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1

Introdução

Agradecemos-lhe ter escolhido a Medtronic Diabetes como seu aliado para o ajudar a si e aos

seus doentes na tarefa de melhor gerir a diabetes. Acreditamos que colherá vantagens da

tecnologia de ponta do software CareLink® Pro e do respectivo interface de utilizador

simples,  com base numa estrutura de menus.

O CareLink Pro permite-lhe captar, guardar e elaborar relatórios dos dados de diagnóstico e

tratamento dos doentes. Também pode utilizá-lo para aceder aos dados da bomba de

insulina, do medidor e da glicose registada pelo sensor que os seus doentes enviaram para o

CareLink® Personal,  um sistema de gestão da terapia com base na Web que funciona em

conjunto com o CareLink Pro.

Funções

O CareLink Pro é um software de gestão da terapia da diabetes para instalar num computador

pessoal (PC).  Integra as seguintes funções:

• podem ser criados registos do doente para guardar os dados recolhidos do dispositivo do

doente, além dos dados da terapia da sua conta CareLink Personal;

• podem ser enviados dados das bombas de insulina, monitores e medidores de glicose no

sangue para o sistema, onde são guardados e usados para elaborar relatórios;

• como característica opcional, é possível efectuar uma ligação ao sistema CareLink Personal

para aceder aos dados do dispositivo que o doente aí tiver guardado. Esta é a forma ideal de

criar relatórios actualizados entre consultas, podendo eliminar a necessidade de ler os dados

do dispositivo durante as consultas;

• podem ser criados diferentes relatórios de tratamento a partir dos dados do dispositivo

guardados no registo do doente. Os relatórios facilitam as respostas às preocupações com a

terapia, como por exemplo, com a adesão do doente, os padrões e as excepções

identificados;

• o sistema alerta-o quando existem actualizações do software para transferir e instalar no

computador. Deste modo, tem sempre acesso às funções mais recentes;
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• existe ainda uma função Guide Me que ajuda os utilizadores inexperientes do CareLink Pro.

Fornece indicações e sugestões acerca das tarefas que estão a realizar;

• existe um sistema de ajuda integrada no software para facultar informações sobre áreas de

interesse específicas.

Segurança

• O CareLink Pro pode ser protegido por uma palavra-passe.

• A transmissão de dados do doente a partir do CareLink Personal é encriptada pela tecnologia

de referência Secure Sockets Layer (SSL).

Documentos relacionados

Cada um destes documentos da Medtronic MiniMed contém informações específicas de cada

dispositivo que não são tratadas em pormenor neste guia do utilizador.

NOTA: Relativamente a medidores fabricados por outras empresas, consulte as instruções

do fabricante que acompanham o medidor.

• Guia do utilizador da bomba de insulina Paradigm

• Guia do utilizador do monitor Guardian REAL-Time

• Guia do utilizador das funções do sensor

• Guia do utilizador ComLink

• Guia do utilizador CareLink USB

Assistência

Se precisar de ajuda adicional com este sistema, contacte o seu representante local.  Aceda ao

seguinte Web site para consultar os dados internacionais de contacto:

http://www.medtronicdiabetes.com/help/contact/locations.html

Dispositivos suportados

O CareLink Pro recolhe os dados dos seguintes dispositivos.

NOTA: Alguns dispositivos suportados por este software podem não estar disponíveis em

todos os países em que a utilização deste software está aprovada.
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Bombas de insulina/Monitores de glicose

Bombas de insulina Medtronic MiniMed: 508

Bombas de insulina da série Paradigm® da Medtronic
MiniMed:

511, 512, 712, 515, 715, 522,  722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Monitores Guardian REAL-Time:
CSS-7100

CSS-7100K

Fabricante Medidores de glicemia

Dispositivos de parceiros da Medtronic Diabetes:
• Bayer CONTOUR® LINK

• Monitor de glicose no sangue BD Paradigm
Link®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

Bayer:

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

BD: • Logic®

Família Bayer Ascensia® DEX®, incluindo estes medidores
compatíveis:

• Ascensia® DEX®

• Ascensia® DEX® 2

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Família Bayer Ascensia ELITE™, incluindo estes
medidores compatíveis:

• Ascensia ® ELITE™

• Glucometer ELITE® XL
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Fabricante Medidores de glicemia

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra™

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Dispositivos de comunicação

Com-Station
Para usar com a bomba Medtronic MiniMed 508
(Consulte o Guia do utilizador Com-Station para
mais pormenores sobre o hardware necessário).

ComLink

Para usar com a bomba MiniMed Paradigm e com
o monitor Guardian REAL-Time (Consulte o Guia
do utilizador ComLink para mais pormenores
sobre o hardware necessário).

Monitor de glicose no sangue Paradigm Link®

Para usar com uma bomba MiniMed Paradigm ou
com o monitor Guardian REAL-Time (Consulte o
Guia do utilizador do monitor de glicose no
sangue Paradigm Link® para mais pormenores
sobre o hardware necessário).

CareLink® USB
Para usar com a bomba de insulina MiniMed da
série Paradigm e com o monitor Guardian REAL-
Time.

Cabo de comunicação de dados

Para usar com medidores de glicose no sangue
de outros fabricantes. Cada fabricante de
medidores fornece um cabo de comunicação de
dados.

Nota: Se um fabricante de medidor fornecer um
cabo USB em vez de um cabo série para envio de
dados, é necessário instalar o controlador de
software fornecido por esse fabricante.

Informe-se igualmente junto do fabricante do
medidor para garantir que o controlador USB é
compatível  com o seu sistema operativo. Alguns
controladores USB poderão não estar disponíveis
para sistemas operativos de 64 bits.

Dispositivos equivalentes

Quando adiciona um dispositivo ao sistema, deve seleccionar a respectiva marca e modelo

numa lista. Se a marca e modelo de um dispositivo não se encontrarem na lista, consulte a

seguinte tabela para descobrir um dispositivo equivalente que possa usar.

CareLink Pro Guia do utilizador   Introdução 4



Se o seu doente usar um destes dispositivos Seleccione este dispositivo

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™

Precision Xceed™ Optium Xceed™

Encomenda

Para encomendar produtos Medtronic Diabetes, contacte o seu representante local.  Aceda ao

seguinte URL para consultar os dados internacionais de contacto:

http://www.medtronicdiabetes.com/help/contact/locations.html

NOTA: Os medidores podem ser encomendados às empresas que os fabricam.

Como utilizar este guia

NOTA: Este guia do utilizador mostra apenas ecrãs exemplificativos do software. Os ecrãs

reais do software podem ser ligeiramente diferentes.

Consulte o Glossário para obter as definições dos termos utilizados e das funções da bomba

de insulina. Os termos e símbolos utilizados neste guia encontram-se na tabela seguinte.

Termo / símbolo Significado

Clicar Premir o botão esquerdo do rato sobre um objecto
no ecrã para o seleccionar

Fazer duplo clique Premir duas vezes o botão esquerdo do rato sobre
um objecto no ecrã para o abrir

Clicar com o botão direito do rato Premir o botão direito do rato sobre um objecto
no ecrã para visualizar outra janela ou menu

Texto a negrito
Utilizado para um botão, nome de ecrã, nome de
campo ou opção de menu. Por exemplo: Patient >
New Patient  (Doente > Novo doente)

NOTA: Fornece informações adicionais sobre um
procedimento ou passo.
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Termo / símbolo Significado

ATENÇÃO:
Avisa de um potencial perigo que, caso não seja
evitado, pode resultar em danos ligeiros a
moderados no equipamento ou programa de
software.

AVISO:

Notifica-o de um possível perigo que, caso não
seja evitado, pode resultar em morte ou
ferimentos graves. Pode ainda descrever possíveis
reacções adversas graves e perigos para a
segurança.

Segurança do utilizador

Indicações de utilização

O sistema CareLink Pro destina-se a ser utilizado como ferramenta auxiliar na gestão da

diabetes. A finalidade deste sistema é transformar em relatórios CareLink Pro a informação

recebida de bombas de insulina, medidores de glicose no sangue e sistema de monitorização

contínua de glicose. Os relatórios fornecem informação que pode ser usada para identificar

tendências e acompanhar actividades diárias — como os carbohidratos consumidos, as horas

das refeições, a administração de insulina e as leituras de glicemia.

Avisos

• Este sistema destina-se a ser usado por um médico familiarizado com a gestão da diabetes.

• Os resultados do sistema não se destinam a produzir aconselhamento médico e não devem

constituir a base do mesmo.

• Este produto apenas deve ser usado com os dispositivos suportados que são enumerados

neste documento (Consulte Dispositivos suportados na página 2).

• Os doentes devem ser aconselhados a monitorizar os seus níveis de glicemia pelo menos 4 –

6 vezes ao dia.

• Os doentes devem ser aconselhados a não alterar o tratamento sem consultarem o seu

médico.

• Os doentes devem ser aconselhados a tomar decisões de tratamento com base nas

orientações do médico e nos resultados do medidor de glicose no sangue e não nos

resultados do sensor de glicose.

Contra-indicações

Este software não deve ser usado com dispositivos que não estejam incluídos na lista de

Dispositivos suportados na página 2.  Este produto não deve ser usado para tratar outros

problemas médicos que não a diabetes.

Antes de abrir este software, encerre qualquer um dos seguintes programas de software que

possam estar a ser executados no computador:

• Software Solutions™ para o sistema CGMS® (7310)

• Software para medidores e bombas de insulina Solutions® (7311)

• Software Guardian® Solutions® (7315)
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• ParadigmPAL™ (7330)

• Software CareLink® Personal (7333)

• Software Solutions® para CGMS®iPro (7319)
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2

Primeiros passos

As informações a seguir apresentadas orientam-no ao longo do processo de iniciar o software

CareLink Pro, abrir e fechar os registos dos doentes e configurar as preferências a aplicar a

todos os doentes do sistema.

Antes de começar

Se for a primeira vez que está a utilizar o CareLink Pro, assegure-se de que configura as

preferências gerais (consulte Preferências gerais na página 13). Estas preferências

determinam a forma como certos itens são visualizados no software e nos relatórios, e como o

sistema vai comunicar com a Internet.

As preferências podem ser configuradas em qualquer altura. É aconselhável aguardar até que

esteja familiarizado com o software CareLink Pro antes de configurar as outras preferências.

Principais tarefas do sistema

A tabela seguinte contém as principais tarefas que deve executar da primeira vez que

configurar e utilizar o CareLink Pro. Indica-lhe ainda a parte deste guia do utilizador na qual se

aborda cada uma das tarefas.

Etapa Localização

Familiarizar-se com a interface do utilizador do CareLink
Pro. Navegar no sistema na página 9

Definir  as opções globais do sistema que a sua
instituição de saúde utiliza.

Configurar as preferências do sistema na
página 13

Criar perfis  para cada um dos doentes. Adicionar novos perfis  na página 22

Efectuar a ligação às contas do CareLink Personal dos
seus doentes.

Efectuar ligação ao CareLink Personal na
página 23

Adicionar a bomba e medidores dos doentes ao
respectivo perfil. Adicionar um dispositivo na página 30

Ler os dados da bomba e medidores dos doentes. Ler dados do dispositivo na página 37
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Etapa Localização

Configurar e elaborar relatórios para cada um dos
doentes. Criação de relatórios na página 40

Efectuar regularmente cópias de segurança da base de
dados do CareLink Pro.

Efectuar cópias de segurança da base de dados na
página 52

Actualizar o software CareLink Pro. Aplicar actualizações de software na página 50

Navegar no sistema

Antes de trabalhar com o software CareLink Pro, deve familiarizar-se com a interface de

utilizador. O interface do utilizador inclui menus, uma barra de ferramentas, uma barra de

navegação, espaços de trabalho e uma janela Guide Me (Orientação).

Abertura do CareLink Pro

1 Faça duplo clique no ícone CareLink Pro  no ambiente de trabalho do computador ou

seleccione Medtronic CareLink Pro na lista de Programas do menu Iniciar do Windows.

Se a sua instituição de saúde exigir que introduza uma palavra-passe, aparecerá um ecrã de

início de sessão.

a. Digite a sua palavra-passe no campo Password  (Palavra-passe).

NOTA: A introdução de uma palavra-passe é uma função opcional configurada
durante o processo de instalação.

b. Clique em LOGIN (Iniciar sessão).

Surge o ecrã de arranque.

2 Para iniciar um novo registo de doente, clique em New Patient  (Novo doente). Para abrir um

registo de doente a partir de uma lista de doentes existente no sistema, clique em Open

Patient  (Abrir doente).

Espaços de trabalho

Se tiver o registo de um doente aberto, pode clicar num dos botões da barra de navegação

para visualizar o espaço de trabalho correspondente. Use estes espaços de trabalho para

introduzir ou seleccionar informações de modo a efectuar tarefas do CareLink Pro para esse

doente.
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Profile (Perfil):   Permite-lhe conservar os
dados do doente guardados, como por
exemplo, o nome e a data de nascimento.
Este espaço de trabalho permite-lhe ainda
efectuar a ligação à conta CareLink Personal
de um doente.

Devices (Dispositivos): Permite-lhe guardar
as informações necessárias para ler os
dispositivos de um doente.

Reports (Relatórios): Permite-lhe seleccionar
parâmetros e escolher os relatórios a elaborar
para o doente.

Até ser acrescentado e guardado o perfil de um doente, apenas o espaço de trabalho de

Profile (Perfil)  é acessível para esse doente. Até serem acrescentados os dispositivos de um

doente, apenas os espaços de trabalho de Profile (Perfil) e Devices (Dispositivos) são

acessíveis para esse doente.

Barra de ferramentas

A barra de ferramentas do CareLink Pro fornece um acesso rápido às funções frequentemente

usadas. A barra de ferramentas contém os seguintes botões.

Botão Nome Função

Add Patient (Adicionar doente)

Abre um espaço de trabalho em
Profile (Perfil) para que possa
acrescentar o registo de um
novo doente ao sistema.

Open Patient (Abrir doente)

Abre a tabela Patient Lookup
(Localização de doentes) na
qual pode escolher um registo
de doente existente para
visualizar.

Guide Me (Orientação)

Mostra ou oculta a janela Guide
Me (Orientação). Clique para
obter sugestões do sistema
associadas ao contexto.

Separadores do doente

Ao abrir o registo de um doente, surge um separador ao longo da barra de ferramentas com o

nome do doente. Quando o separador está activo, o registo do doente e o espaço de trabalho

estão activos, sendo possível executar tarefas do CareLink Pro em relação a esse doente.
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Para activar um registo de doente para que possa trabalhar com o mesmo, clique no

separador relativo a esse doente. Para fechar um registo de doente, clique no botão Close
(Fechar)  no separador.

A função Guide Me (Orientação)

A função Guide Me (Orientação) está sempre presente no CareLink Pro. Abre uma janela com

indicações e sugestões do sistema associadas ao contexto, sobre acções que pode realizar a

partir do ponto do sistema que se encontra activo. As janelas Guide Me (Orientação) podem

incluir ainda hiperligações >>learn more  (Saber mais).  Ao clicar nestas hiperligações, o

utilizador é levado até à secção associada da ajuda online, para mais pormenores. A função

Guide Me (Orientação) está normalmente activada. No entanto, é possível desactivá-la em

qualquer altura.

Activar e desactivar a função Guide Me (Orientação)

Para activar e desactivar a função Guide Me (Orientação), proceda da seguinte forma:

• Clique no botão Guide Me (Orientação). 

• Seleccione Help  (Ajuda) > Guide Me (Orientação).
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Abrir registos de doentes

É possível abrir um máximo de seis registos de doentes em simultâneo. Se ainda não tiver

criado quaisquer perfis de doentes, consulte Adicionar novos perfis na página 22.

1 Seleccione File (Ficheiro) > Open Patient  (Abrir doente) ou clique no botão Open Patient

(Abrir doente).  É visualizada uma lista de doentes semelhante à seguinte.

NOTA: Se receber uma mensagem indicando que estão abertos demasiados registos

de doentes, clique em OK, feche um registo e continue.

2 Localize a lista de doentes digitando parcial ou integralmente o seu nome no campo Find a

Patient  (Localizar um doente). Quando a lista de doentes aparecer realçada, clique em OPEN

(Abrir), faça duplo clique sobre a lista ou prima ENTER. Pode ainda navegar na lista, usando as

setas ascendente e descendente do teclado.

Surge o espaço de trabalho Devices (Dispositivos) (se os dispositivos ainda não tiverem sido

acrescentados) ou Reports  (Relatórios) do doente.

3 Para ver o espaço de trabalho Profile  (Perfil) do doente, clique no botão Profile (Perfil)

 na barra de navegação.

Fechar registos de doentes

1 Assegure-se de que o registo do doente que pretende fechar está activo (separador

realçado).

2 Efectue uma das seguintes acções:

a. Seleccione File > Close Patient (Ficheiro > Fechar doente).

b. Clique no botão Close (Fechar)  no separador do doente.
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c. Prima Ctrl+F4.

Configurar as preferências do sistema

Estas preferências aplicam-se a todos os doentes do sistema. Para saber mais sobre as

preferências que se aplicam apenas a doentes individuais,  consulte Verificação das

configurações dos relatórios na página 43.

As preferências apresentam-se divididas pelos seguintes grupos:

• General (Gerais)

- Glucose units (Unidades de glicemia)

- Carbohydrate units (Unidades de carbohidratos)

- Communications (Comunicações)

- Troubleshooting (Resolução de problemas)

• Patient Profile (Perfil do doente)

- Seleccione e disponha os campos de dados nos perfis dos doentes.

• Patient Lookup (Localização de doentes)

- Modifique e altere a ordem dos campos visualizados quando selecciona Open Patient

(Abrir doentes) para ver uma lista de doentes.

• Report Generation (Criação de relatórios)

- Escolha os campos de dados que pretende visualizar ao seleccionar na Data Table

(Tabela de dados) os elementos que devem figurar no relatório Daily Detail (Diário

exaustivo).

Preferências gerais

Utilize o separador General (Geral) para definir a forma como o software apresenta

determinados tipos de informações, bem como para estabelecer as suas preferências de

comunicação externa.

1 Se ainda não estiver activo, clique no separador General (Geral).

CareLink Pro Guia do utilizador   Primeiros passos 13



2 Seleccione Tools > Options  (Ferramentas > Opções). Surge a janela seguinte.

3 Clique para seleccionar o botão de opção relativo ao valor que pretende:

- Glucose Units (Unidades de glicemia): mg/dL ou mmol/L

- Carbohydrate Units  (Unidades de carbohidratos): grams ou Exchanges (gramas ou

porções)

a. Se tiver seleccionado Exchanges  (Porções) como as Carbohydrate Units  (Unidades de

carbohidratos), digite o número adequado no campo grams are equal to 1 Exchange

(gramas equivalem a 1 porção).

4 Clique para seleccionar ou limpar a caixa de verificação na secção Chart Options > Overview

Report (Opções de tabela > Perspectiva geral). Se a caixa de verificação estiver seleccionada,

a aplicação irá associar as leituras de GS do quadro Meter Glucose Overlay (Sobreposição de

glicose do medidor) a linhas (Trata-se de um quadro apresentado no relatório Perspectiva

geral do sensor e medidor de glicose).

5 Em preferências de Communications (Comunicações) que surge a seguir, clique para

seleccionar a caixa de verificação (activar) ou para limpar a caixa de verificação (desactivar):

NOTA: Assegure-se de que respeita as directrizes da sua instituição de saúde ou

departamento de TI ao configurar as preferências de comunicação.

- Automatically check for software updates (Verificar automaticamente a existência

de actualizações do software):  se for seleccionada, será enviada uma notificação a cada

sistema que estiver a executar o CareLink Pro, sempre que ficar disponível uma
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actualização do software. O utilizador activo terá então a oportunidade de transferir e

instalar as actualizações. Para evitar que tal aconteça e para instituir uma distribuição

controlada das actualizações do software, pode limpar esta caixa de verificação.

- Synchronize with Medtronic CareLink® Personal  (Sincronizar com o Medtronic

CareLink® Personal): Se pretender que o sistema efectue automaticamente a

sincronização com os dados do doente no CareLink Personal, de cada vez que abrir o

respectivo perfil, seleccione esta caixa de verificação. Se limpar esta caixa de verificação,

terá de sincronizar manualmente os dados do CareLink Personal de cada doente.

6 Clique para seleccionar ou limpar a caixa de verificação na secção Troubleshooting

(Resolução de problemas). Se a caixa de verificação for seleccionada, a aplicação guardará

um registo das leituras do dispositivo para a resolução de problemas.

7 Clique em OK para guardar as preferências gerais.

Preferências do perfil do doente

Trata-se de uma configuração global que define o conteúdo dos perfis.  Pode personalizar

campos no espaço de trabalho Profiles (Perfis) de forma a incluir informações de maior

relevância para a sua instituição de saúde. Pode adicionar ou remover campos, criar os seus

próprios campos personalizados e determinar a ordem pela qual os campos aparecerão na

janela.

1 Seleccione Tools > Options  (Ferramentas > Opções).

2 Clique no separador Patient Profile  (Perfil do doente). Surge a janela seguinte.

NOTA: Use as caixas de verificação para escolher os campos que pretende ter no
perfil.  Use os botões com setas ascendente e descendente para colocar os campos em

ordem.
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Escolher campos de dados

1 Use as caixas de verificação para adicionar os campos que pretende.

NOTA: Os campos de First e Last Name (Nome e apelido) não podem ser removidos.

2 Para retirar um campo de um perfil, limpe a respectiva caixa de verificação.

3 Para fazer com que um campo seja de preenchimento obrigatório, seleccione a caixa de

verificação da coluna Required (Obrigatório). Este tipo de campo tem obrigatoriamente de

ser preenchido para que possa ser criado um perfil.

Adicionar um campo personalizado

1 Seleccione a caixa de verificação à esquerda de um campo personalizado vazio.

2 Digite o texto para atribuir um nome ao campo (por exemplo, Emergency Contact (Contacto

de emergência)). Este é o nome de campo que aparecerá no perfil do doente.

3 Para fazer com que o campo seja de preenchimento obrigatório, seleccione a caixa de

verificação da coluna Required (Obrigatório).

NOTA: Para retirar um campo personalizado do perfil,  limpe a caixa de verificação ao
lado do(s) campo(s) que pretende remover.

Alterar a ordem dos campos de dados

Seleccione o campo que pretende deslocar e clique na seta ascendente ou descendente 

para o deslocar (As setas nas partes superior ou inferior deslocam o campo para o topo ou

para o fundo da lista).

Finalizar as preferências do perfil do doente

Quando a lista Field Order (Ordem dos campos) tiver todos os campos pretendidos na ordem

correcta, clique em OK.

Os perfis dos doentes apresentam agora os campos e a ordem dos campos que acabou de

seleccionar.

Preferências de Patient Lookup (Localização de doentes)

A tabela Patient Lookup (Localização de doentes) é utilizada para pesquisar e abrir um registo

de doente. A tabela inclui todos os doentes existentes na base de dados e fornece informações

de identificação a partir do perfil do doente. Dispõe da opção de personalizar as informações

que são apresentadas nesta tabela, bem como a ordem pela qual as colunas aparecem. Para

personalizar a tabela Patient Lookup (Localização de doentes), proceda da seguinte forma:

1 Seleccione Tools > Options  (Ferramentas > Opções).
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2 Clique no separador Patient Lookup  (Localização de doentes). Surge a janela seguinte.

NOTA: Use as caixas de verificação para escolher os dados que pretende ter na tabela

Patient Lookup (Localização de doentes).  Use os botões com setas ascendente e

descendente para colocar as colunas em ordem.

Escolher dados para visualizar

Use as caixas de verificação para seleccionar o tipo de dados que pretende visualizar ou para

apagar os dados que não pretende visualizar na tabela Patient Lookup (Localização de

doentes).

Alterar a ordem das colunas

Para alterar a ordem das colunas na tabela Patient Lookup (Localização de doentes),

seleccione a coluna a deslocar e clique nas setas ascendente ou descendente  (As setas

nas partes superior ou inferior deslocam uma coluna de dados para o topo ou para o fundo da

lista).

A coluna de dados no topo da lista Column Display Order (Ordem de visualização das colunas)

aparecerá na primeira coluna da tabela Patient Lookup (Localização de doentes).  A coluna de

dados ao fundo será visualizada na última coluna da tabela.

Finalização das preferências de Patient Lookup (Localização de doentes)

Quando a lista Column Display Order (Ordem de visualização das colunas) tiver todos os

dados pretendidos na ordem correcta, clique em OK.

A tabela Patient Lookup (Localização de doentes) apresenta agora todos os dados e colunas

na ordem que acabou de seleccionar.
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Preferências para a criação de relatórios

A Data Table (Tabela de dados) surge na janela Select and Generate Reports (Seleccionar e

gerar relatórios).  Esta tabela é utilizada durante a elaboração de relatórios. Contém

informações diárias derivadas dos dispositivos do doente e, caso seja aplicável, da respectiva

conta do software CareLink Personal.  Os dados fornecidos nesta tabela ajudam a determinar

quais os dias que requerem um relatório Daily Detail (Diário exaustivo).  Ajuda também a

decidir quais os restantes relatórios a elaborar.

A sua instituição de saúde pode personalizar os dados que são apresentados nesta tabela,

incluindo a ordem pela qual são apresentados, de forma a reflectir os mais relevantes para a

sua clínica.

NOTA: Para ver como estas preferências se aplicam à Data Table (Tabela de dados)

durante a criação de um relatório, consulte Selecção de tipos de relatórios e datas de

inclusão na página 45.

1 Seleccione Tools > Options  (Ferramentas > Opções).

2 Clique no separador Report Generation  (Criação de relatórios). Surge a janela seguinte.

Escolher dados para visualizar

Use as caixas de verificação para seleccionar o tipo de dados que pretende visualizar ou para

apagar os dados que não pretende visualizar na Data Table (Tabela de dados).

As informações a seguir apresentadas estão disponíveis para inclusão na Data Table (Tabela

de dados).
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Nome da coluna Definição

№ of Meter Readings (N.º de leituras do medidor)
A quantidade de leituras, relativas à data
especificada, que foram gravadas pelos dispositivos
incluídos.

Meter Readings Average (Média de leituras do
medidor)

A média das leituras de glicose gravadas pelos
dispositivos incluídos.

Sensor Duration (Duração do sensor)
A quantidade de tempo dentro da data especificada
para a qual foi gravada a data do sensor. Os valores
são -- (nenhum), 0:05 - 24:00.

Sensor Average (Média do sensor) A média de leituras do sensor gravada na data
especificada.

Highest Reading (Leitura mais alta) A leitura de glicose mais alta (derivada de um
sensor ou medidor) relativa à data.

Lowest Reading (Leitura mais baixa) A leitura de glicose mais baixa (derivada de um
sensor ou medidor) relativa à data.

Avg AUC Below Target (AUC méd. abaixo do
objectivo)

Área média por baixo da curva abaixo do objectivo
do doente.

Avg AUC Above Target (AUC méd. acima do
objectivo)

Área média por cima da curva abaixo do objectivo
do doente.

Total Carbs (Total de carbohidratos)

A soma de todas as quantidades de carbohidratos
(arredondada para o grama ou para a porção 0,1
mais próxima, dependendo da unidade de medida
usada) relatadas durante o dia através de eventos da
Bolus Wizard (Ajuda de Bolus) ou de marcadores de
carbohidratos na bomba ou no monitor Guardian.

Suspend Duration (Duração da suspensão)
A quantidade de tempo de suspensão da bomba na
data especificada. Os valores são -- (nenhum), 0:01 -
24:00.

№ of Rewinds (N.º de rebobinagens) O número de eventos de rebobinagem relativo à
data especificada.

№ of Primes (or Fills) (N.º  de preparações (ou
enchimentos))

O número de eventos de preparação (ou eventos de
enchimento) registado relativamente à data
especificada.

Prime (or Fill) Volume (U) (Volume de preparação (ou
enchimento) (U))

O volume total de insulina utilizada para eventos de
preparação (ou eventos de enchimento) na data
especificada.

Total Insulin (U) (Total de insulina (U)) O volume total de insulina administrada durante a
data especificada, conforme registado pela bomba.

Total Basal  (U) (Índice basal  total (U))

O volume total de insulina basal administrada
durante a data especificada (o total de insulina
administrada,  menos a soma de todos os bolus
administrados).

Total Bolus (U) (Bolus total (U))
O volume total de insulina administrada em bolus
durante a data especificada, conforme registado pela
bomba.

Basal  % (% do índice basal) Apresenta a proporção (em valores % inteiros) de
insulina basal para insulina total.

Bolus % (% de bolus) Apresenta a proporção (em valores % inteiros) de
insulina de bolus para insulina total.

№ of Boluses (N.º de bolus) O número de eventos de bolus registados
relativamente à data especificada.

Bolus Wizard Events (Eventos da ajuda de bolus) O número total de eventos da ajuda de bolus
registados relativamente à data especificada.
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Nome da coluna Definição

Bolus Wizard Overrides (Substituições da ajuda de
bolus)

O número de eventos da ajuda de bolus em que a
quantidade de insulina administrada é diferente da
quantidade recomendada.

№ of Meal Boluses (N.º de bolus de refeição)
O número de eventos da ajuda de bolus com
quantidades de carbohidratos superiores a zero que
foram registados na data especificada.

№ of Correction Boluses (N.º de bolus de correcção)
O número de eventos da ajuda de bolus com
quantidades de correcção superiores a zero que
foram registados na data especificada.

№ of Manual Boluses (N.º de bolus manuais)
O número de eventos de bolus, registados durante a
data, que não se trataram de eventos da ajuda de
bolus.

Alterar a ordem das colunas

Para alterar a ordem das colunas na Data Table (Tabela de dados),  seleccione a coluna a

deslocar e clique nas setas ascendente ou descendente  (As setas nas partes superior ou

inferior deslocam uma coluna de dados para o topo ou para o fundo da lista).

NOTA: Os itens no topo da lista Column Order (Ordem das colunas) aparecerão na

primeira coluna da Data Table (Tabela de dados). Os itens ao fundo serão visualizados na
última coluna da Data Table (Tabela de dados).

Finalização das preferências para a criação de relatórios

Quando a lista Column Order (Ordem das colunas) tiver todos os dados pretendidos na ordem

correcta, clique em OK.

A Data Table (Tabela de dados) apresenta agora todos os dados e colunas na ordem que

acabou de seleccionar.
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3

Espaço de trabalho Profile (Perfil)

Um perfil é semelhante à capa de um processo de doente. Guarda os dados do doente, como

o nome e a data de nascimento. É necessário existir um perfil para que possam ser reunidos e

usados dados sobre o dispositivo nos relatórios da terapia.

O espaço de trabalho Profile (Perfil)  permite-lhe ainda configurar uma ligação à conta

CareLink Personal do doente. Estabelecida uma ligação, é possível recuperar em qualquer

altura os dados do doente guardados no CareLink Personal — sem que o doente esteja

presente.

Antes de começar

Pode personalizar os perfis dos doentes de modo a que contenham apenas o tipo de

informação que pretende recolher. Para mais informações, consulte Preferências do perfil  do

doente na página 15.
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É necessário um nome de utilizador e uma palavra-passe para configurar a ligação à conta

CareLink Personal do doente. O doente tem de estar presente para facultar estes dados.

Adicionar novos perfis

De cada vez que adicionar um doente ao sistema CareLink Pro, tem de começar por preencher

um perfil  para esse doente.

1 Seleccione File > New Patient  (Ficheiro > Novo doente) ou clique no botão Add Patient

(Adicionar doente). 

É apresentado o espaço de trabalho Profile (Perfil).

NOTA: Para adicionar ou alterar campos no perfil  do doente, clique em Customize

fields (Personalizar campos).  Consulte Preferências do perfil  do doente na página 15.

2 Preencha os campos da secção Patient Profile (Perfil do doente).

3 Clique no botão SAVE (Guardar).

O novo perfil de doente é adicionado à base de dados do CareLink Pro. Surge uma

mensagem que confirma que o perfil foi guardado.

Preencher os campos de dados

1 Se um campo de preenchimento obrigatório não estiver completado ao guardar o perfil de

um doente, surge uma mensagem ao lado desse campo. Não poderá guardar esse perfil até

ter digitado algo no campo em questão.

2 Preencha o campo.

3 Clique no botão SAVE (Guardar).

4 Quando a mensagem de confirmação aparecer, clique em OK.

Editar perfis de doentes

1 Verifique se o espaço de trabalho do Profile  (Perfil)  do doente está aberto.

2 Clique em EDIT  (Editar).

3 Edite os dados da secção Patient Profile (Perfil do doente), conforme necessário.

4 Clique no botão SAVE (Guardar).

Surge uma mensagem que confirma que o perfil foi guardado.

Eliminar os dados do doente do sistema

1 Verifique se o espaço de trabalho do Profile  (Perfil)  do doente está aberto.
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2 Verifique se este é o doente que pretende eliminar. Se eliminar o perfil do doente estará

também a eliminar todos os dados do mesmo doente da base de dados do CareLink Pro, não

podendo restaurá-los mais tarde.

3 Clique em >> delete patient record (eliminar registo de doente) acima da secção de

sincronização do perfil.

Surge uma mensagem para o alertar de que todos os dados do doente serão apagados

quando eliminar o registo.

4 Clique em Yes  (Sim) para eliminar o registo do doente.

Efectuar ligação ao CareLink Personal

Se o doente autorizar,  pode configurar uma ligação à respectiva conta CareLink Personal. Esta

ferramenta com base na Web permite aos doentes enviar e guardar dados recolhidos pelo

dispositivo e elaborar vários relatórios de terapia.

Depois de ligar à conta CareLink Personal do doente, pode recuperar os dados do dispositivo

aí guardados. É a solução ideal para criar relatórios de terapia no CareLink Pro entre consultas.

Reduz ainda a necessidade de ler o dispositivo do doente no consultório.

Se um doente ainda não tiver uma conta CareLink Personal,  pode enviar-lhe uma mensagem

de correio electrónico convidando-o a criar uma conta.

Efectuar uma ligação a uma conta já existente

NOTA: O doente tem de estar presente para executar estas etapas.

1 Assegure-se de que está ligado à Internet.

2 Abra o espaço de trabalho do Profile  (Perfil) do doente.

3 Verifique se os campos de preenchimento obrigatório na secção Patient Profile (Perfil do

doente) estão preenchidos.

4 Clique em LINK TO EXISTING ACCOUNT  (Efectuar uma ligação a uma conta já existente).

É visualizado o ecrã de Login (Início de sessão) do CareLink Personal.

5 Peça ao doente para:

a. digitar o seu nome de utilizador e palavra-passe; ou

b. clicar em Sign In  (Inscrição).

Surge uma página Grant Access  (Conceder acesso), com base nas definições de idioma e

região da inscrição do doente.

6 Peça ao doente para:

a. ler os Terms of Use (Termos de utilização);

b. clicar na caixa de verificação ao lado de I agree to the Terms of Use above...  (Concordo

com os termos de utilização anteriores);

c. clicar em Grant Access  (Conceder acesso);
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d. informá-lo quando surgir a página Thank You (Obrigado).

7 Se necessário, pode imprimir os Terms of Use (Termos de utilização) para o doente, clicando

no botão Print  (Imprimir). Está agora ligado à conta CareLink Personal deste doente.

Enviar um convite por correio electrónico

Para enviar uma mensagem de correio electrónico convidando um doente a criar uma conta no

CareLink Personal, siga estas etapas:

1 Abra o espaço de trabalho do Profile  (Perfil) do doente.

2 Verifique se os campos de preenchimento obrigatório na secção Patient Profile (Perfil do

doente) estão preenchidos.

3 Clique em SEND E-MAIL INVITATION TO PATIENT  (Enviar convite por correio electrónico ao

doente).

4 Verifique se os campos Patient Name  (Nome do doente), Email Address (Endereço de

correio electrónico) e Language (Idioma) estão correctamente preenchidos.

5 Clique em SEND  (Enviar).

A área de estado do perfil do doente confirma que a mensagem de correio electrónico foi

enviada.

Obter dados a partir da ligação a uma conta

Se estiver ligado à conta CareLink Personal de um doente, quaisquer novos dados

provenientes desta conta são automaticamente enviados sempre que abrir o respectivo

perfil de doente no CareLink Pro.

NOTA: Para assegurar que isto acontece, vá até Tools > Options > General (Ferramentas >

Opções > Geral) e verifique se assinalou a caixa ao lado de “Synchronize with CareLink

Personal” (Sincronizar com CareLink Personal).
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Siga estas etapas para obter os dados do CareLink Personal do doente sempre que abrir o

respectivo perfil de doente:

1 Certifique-se que o espaço de trabalho do Profile (Perfil) do doente está aberto e que o

computador se encontra ligado à Internet.

2 Seleccione Tools > Synchronize Patient Data (Ferramentas > Sincronizar dados do doente).

O ícone de sincronização  no separador do doente gira. Quando o ícone pára, o processo

está completo.

NOTA: Se o doente já não quiser partilhar os respectivos dados do CareLink Personal,
surge uma mensagem que o informa acerca desta situação.

3 Quaisquer dados adicionais recuperados do CareLink Personal aparecerão nos relatórios do

doente.

Anular a ligação à conta CareLink Personal de um doente a partir do CareLink
Pro

É possível anular a ligação à conta CareLink Personal de um doente a partir do CareLink Pro.

Esta opção apenas está disponível depois de ter sido efectuada uma ligação para um doente.

Impede que o CareLink Pro continue a recuperar dados da conta CareLink Personal do doente.

Não afecta a utilização pessoal do doente da sua conta CareLink Personal.

1 Abra o registo do doente e aceda ao espaço de trabalho Profile  (Perfil).

2 Clique em UNLINK ACCOUNT  (Anular ligação à conta).

3 Clique em Yes (Sim) na mensagem de confirmação. O perfil pessoal do doente deixa de estar

ligado ao CareLink Pro.

O estado passa a Not linked (Não ligado) e os botões LINK TO EXISTING ACCOUNT  (Ligar a

uma conta existente) e SEND E-MAIL INVITATION TO PATIENT  (Enviar convite por correio

electrónico ao doente) são visualizados.
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Configuração do hardware

Para ler dados directamente a partir de um dispositivo, deverá ter o dispositivo do doente e

quaisquer cabos ou dispositivos de comunicação necessários para transferir os dados para o

seu computador.

Em alternativa, se o doente tiver enviados os dados do dispositivo para a respectiva conta

CareLink Personal,  pode obter os dados efectuando ligação a esta conta. Para efectuar ligação

à conta CareLink Personal de um doente, consulte Efectuar ligação ao CareLink Personal na

página 23.

Ligação de dispositivos

Reveja o diagrama geral para ficar com uma ideia geral de como deve configurar os

dispositivos para que estes comuniquem com o computador. Os diagramas que se seguem

ilustram aspectos específicos da comunicação entre dispositivos.

Para mais pormenores, siga as instruções do CareLink Pro durante a leitura dos dispositivos.
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Descrição geral da configuração do hardware

O exemplo seguinte mostra o CareLink USB a ser utilizado para comunicar entre a bomba de

insulina e o computador.

Exemplos de ligação com cabo série e USB:
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ComLink opcional para utilizar com a bomba de insulina da série Paradigm:

Com-Station opcional para utilizar com a bomba de insulina Medtronic MiniMed 508:
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5

Espaço de trabalho Devices (Dispositivos)

As informações que serão necessárias para ler o dispositivo de um doente, tais como a marca,

o modelo e o número de série, encontram-se guardadas no espaço de trabalho Devices

(Dispositivos).  Assim, não é necessário indicá-los sempre que efectuar uma leitura de dados

no dispositivo.

Os dispositivos presentes no espaço de trabalho Devices (Dispositivos) encontram-se

guardados numa de duas listas — Active Devices (Dispositivos activos) ou Inactive Devices

(Dispositivos inactivos).  Quando adiciona um dispositivo, este é automaticamente colocado

na lista Active Devices (Dispositivos activos).  Apenas pode ler dados em dispositivos incluídos

na lista Active Devices (Dispositivos activos).  Estes são os dispositivos mais provavelmente

usados nessa altura pelo doente.

Outros dispositivos que pertençam ao doente mas que não estejam a ser utilizados nesse

momento, podem ser guardados na lista Inactive Devices (Dispositivos inactivos). Esta acção

mantém a informação no ficheiro. Estes dispositivos podem ser activados em qualquer altura.
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Antes de começar

Antes de abrir o espaço de trabalho Devices (Dispositivos) de um doente, este último tem de

ter um perfil guardado no sistema. Consulte Adicionar novos perfis na página 22.

Para adicionar um dispositivo ou efectuar uma leitura directa de dados, o dispositivo tem de

estar em comunicação com o computador. Consulte Ligação de dispositivos na página 26 para

saber como pode configurar os dispositivos de modo a que estes comuniquem com o

computador.

Adicionar um dispositivo

É possível obter dados da conta CareLink Personal do doente relativamente a um dispositivo

que ainda não tenha sido adicionado. Estes dispositivos serão automaticamente adicionados

no momento da sincronização de dados entre o CareLink Personal e o CareLink Pro.

NOTA: Apenas pode existir uma bomba de insulina activa por doente. Se adicionar uma

nova bomba de insulina, a bomba existente passará para a lista de dispositivos

inactivos.

Adicionar uma bomba de insulina Medtronic ou monitor Guardian

1 Assegure-se de que o dispositivo que está a adicionar foi configurado para comunicar com o

computador (Consulte as etapas de ligação em Ligação de dispositivos na página 26).

2 Clique no separador do doente ou faça duplo clique no respectivo nome na tabela Patient

Lookup (Localização de doentes).

3 Clique em Devices (Dispositivos)  para aceder ao espaço de trabalho Devices

(Dispositivos) do doente.

4 Clique em ADD DEVICE  (Adicionar dispositivo).
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5 Seleccione Medtronic Pump/Guardian  (Bomba de insulina Medtronic/Guardian). Surge o

Assistente Add Medtronic Pump/Guardian  (Adicionar bomba de insulina Medtronic/

Guardian).

NOTA: O modelo da bomba de insulina encontra-se inscrito na parte posterior da

bomba ou no ecrã de estado da bomba.

6 Seleccione o botão de opções para especificar o dispositivo que vai adicionar.

Se tiver seleccionado a opção MiniMed 508 pump  (bomba de insulina MiniMed 508), passe

à etapa 9.

7 Clique em NEXT (Seguinte). Aparece a página Serial Number  (Número de série).

NOTA: Aparecerá uma mensagem de erro se não introduzir o número de série

correcto. Verifique os exemplos desta página e confirme se está a introduzir os
caracteres correctos, inscritos na parte posterior da bomba de insulina. Se necessário,

digite de novo os seis caracteres.
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8 Use os exemplos desta página para localizar o número de série com seis caracteres no

dispositivo que vai ser adicionado (Se precisar de mais ajuda para o localizar, clique em >>

learn more  (Saber mais)). Digite os seis caracteres no campo Device Serial Number
(Número de série do dispositivo).

9 Clique em NEXT (Seguinte). É visualizada uma página Communication Options (Opções de

comunicação) semelhante à seguinte.

10 Clique no menu pendente Choose Port (Escolher porta) e seleccione a porta do seu

computador à qual vai ser ligado o ComLink, o Paradigm Link®, o CareLink USB ou o Com-

Station. Se não tiver a certeza da porta a escolher, seleccione Auto Detect (or USB)

(Detecção automática (ou USB)).

11 Clique em NEXT (Seguinte). É visualizada a página Test Connection  (Testar ligação)

semelhante à seguinte.

12 Siga todas as instruções do dispositivo e clique em TEST  (Teste).

Surge uma mensagem informando-o de que a ligação teve êxito. Se isso acontecer, passe à

etapa seguinte.

NOTA: Este teste não efectua uma leitura dos dados da bomba de insulina, mas
verifica a boa comunicação entre a bomba e o computador.
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Se isso não acontecer, verifique se o hardware de ligação entre o dispositivo e computador

está correctamente ligado. Além disso, pode clicar em BACK (Retroceder) nas páginas do

Assistente para verificar se os dados do dispositivo que introduziu estão correctos.

13 Clique em DONE  (Pronto).

O dispositivo é adicionado à lista de Active Devices (Dispositivos activos) do doente.

Adicionar um medidor

1 Clique no separador do doente ou faça duplo clique no respectivo nome na tabela Patient

Lookup (Localização de doentes).

2 Assegure-se de que o medidor que está a adicionar está em comunicação com o computador

(Consulte as etapas de ligação em Ligação de dispositivos na página 26).

3 Clique no botão Devices  (Dispositivos) para aceder ao espaço de trabalho Devices

(Dispositivos) do doente.

4 Clique no botão ADD DEVICE (Adicionar dispositivo).

5 Seleccione Blood Glucose Meter  (Medidor de glicose no sangue). Surge o Assistente Add

Blood Glucose Meter  (Adicionar medidor de glicose no sangue).

6 Clique no obtão de opções para seleccionar a marca correcta do medidor.
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7 Clique em NEXT (Seguinte). Aparece a página Meter Model  (Modelo do medidor) (esta

página difere dependendo do fabricante do medidor).

8 Clique para seleccionar o modelo de medidor que vai adicionar.

9 Clique em NEXT (Seguinte). Aparece a página Communication Options (Opções de

comunicação).

NOTA: Apenas as opções que forem válidas para o medidor que está a adicionar ficam
disponíveis para selecção.

10 Clique no menu pendente Choose Port (Escolher porta) e seleccione a porta do seu

computador à qual vai ser ligado o ComLink, o Paradigm Link ou o CareLink USB. Se não tiver

a certeza da porta a escolher, seleccione Auto Detect (or USB)  (Detecção automática (ou

USB)).
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11 Clique em NEXT (Seguinte). Aparece a página Test Connection  (Testar ligação).

12 Siga todas as instruções relativas ao dispositivo e clique em TEST  (Testar).

Surge uma mensagem informando-o de que a ligação teve êxito. Se isso acontecer, passe à

etapa seguinte.

Se isso não acontecer, verifique se o hardware de ligação entre o dispositivo e computador

está correctamente ligado. Além disso, pode clicar em BACK (Retroceder) no Assistente para

verificar se os dados que introduziu estão correctos.

13 Clique em DONE  (Pronto).

O medidor é adicionado à lista de Active Devices (Dispositivos activos) do doente.

Activar ou inactivar um dispositivo

Os dispositivos de doentes podem ser deslocados entre a lista Active Devices (Dispositivos

activos) e a lista Inactive Devices (Dispositivos inactivos), conforme necessário. Um dispositivo

tem de estar activo para que a leitura de dados no mesmo seja possível.

Pode ter todos os medidores que quiser na lista Active Devices (Dispositivos activos) mas

apenas uma bomba de insulina. Verifique se pretende inactivar a bomba que está activa antes

de adicionar uma nova.

Inactivar um dispositivo

1 Clique no separador do doente ou faça duplo clique no respectivo nome na tabela Patient

Lookup (Localização de doentes).

2 Clique no botão Devices  (Dispositivos) para aceder ao espaço de trabalho Devices

(Dispositivos) do doente. Os dispositivos podem aparecer na lista com o nome de um

dispositivo equivalente. Consulte Dispositivos suportados na página 2.
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3 Clique em >> make this device inactive  (Inactivar este dispositivo) sob o dispositivo que

pretende inactivar. O dispositivo desloca-se para a lista Inactive Devices (Dispositivos

inactivos).

Reactivar um dispositivo

1 Clique no separador do doente ou faça duplo clique no respectivo nome na tabela Patient

Lookup (Localização de doentes).

2 Clique no botão Devices  (Dispositivos). Aparece o espaço de trabalho Devices (Dispositivos)

do doente.

Os dispositivos podem aparecer na lista com o nome de um dispositivo equivalente.

Consulte Dispositivos suportados na página 2.

3 Clique em >> activate this device (Activar este dispositivo) sob o dispositivo que pretende

activar.

O dispositivo desloca-se para a lista Active Devices  (Dispositivos activos).

Eliminar um dispositivo

Estas etapas eliminarão um dispositivo e respectivos dados do espaço de trabalho Devices

(Dispositivos) e do sistema CareLink Pro:

1 Clique no separador do doente ou faça duplo clique no respectivo nome na tabela Patient

Lookup (Localização de doentes).

2 Clique no botão Devices  (Dispositivos) para aceder ao espaço de trabalho Devices
(Dispositivos) do doente.

Os dispositivos podem aparecer na lista com o nome de um dispositivo equivalente.

Consulte Dispositivos suportados na página 2.

3 Verifique se o dispositivo se encontra na lista Inactive Devices  (Dispositivos inactivos). Se

não estiver, clique em >> Inactivate this device  (Inactivar este dispositivo) sob a respectiva

referência na lista.

4 Clique em >> delete this device  (Eliminar este dispositivo) sob o dispositivo que pretende

eliminar. Surge uma mensagem para o alertar de que o dispositivo e todos os seus dados

serão apagados do registo do doente.

5 Clique em YES  (Sim) para eliminar o dispositivo.

O dispositivo e respectivos dados são removidos do espaço de trabalho Devices

(Dispositivos) e do sistema CareLink Pro. Os dados deste dispositivo deixam de estar

disponíveis para inclusão nos relatórios.
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Ler dados do dispositivo

Uma das formas de obter dados do dispositivo é efectuar uma ligação à conta CareLink

Personal do doente (Consulte Efectuar ligação ao CareLink Personal na página 23).  Outra das

formas é efectuar a leitura directamente a partir do dispositivo do doente, tal  como se

descreve aqui.

Os dados do dispositivo do doente podem ser lidos pelo CareLink Pro se o dispositivo estiver

incluído na lista Active Devices (Dispositivos activos) e estiver em comunicação com o

computador. Tendo obtido estes dados, pode usá-los para elaborar relatórios que o ajudarão

a avaliar a gestão da terapia do doente. Consulte Acerca dos relatórios na página 46  para

obter uma breve descrição dos relatórios disponíveis.

O CareLink Pro pode recolher os seguintes dados de uma bomba de insulina:

• várias configurações da bomba, como o modo de alerta, o volume do sinal sonoro e o

formato horário

• quantidades de insulina basal administradas

• eventos de bolus e quantidades administradas

• entradas da Ajuda de Bolus

• quantidades de enchimento

• períodos de suspensão

• leituras do sensor de glicose ao longo de um período de tempo em bombas com

capacidades de sensor

O sistema também pode recolher dados de um sistema Guardian REAL-Time, incluindo:

• leituras do sensor de glicose (SG)

• valores de coeficiente do sensor

• factores de calibragem do sensor

• marcadores de refeição

• injecções de insulina

Adicionalmente, podem ser enviadas várias informações armazenadas num medidor de

glicose no sangue para o sistema durante uma leitura de dispositivo.
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AVISO: Cancele ou termine todos os bolus activos e índices basais temporários e limpe

todos os alarmes activos. O funcionamento da bomba de insulina será suspenso durante a

leitura. Completada a leitura, verifique se a bomba retomou o funcionamento.

ATENÇÃO: Não use o controlo remoto da bomba de insulina durante a leitura da bomba.

Se a pilha da bomba de insulina estiver fraca, a bomba não enviará dados para o PC.

Substitua a pilha se o estado indicar que a energia da pilha está fraca.

1 Clique no separador do doente ou faça duplo clique no respectivo nome na tabela Patient

Lookup (Localização de doentes).

2 Assegure-se de que o dispositivo do doente está em comunicação com o computador

(Consulte Ligação de dispositivos na página 26).

3 Clique no botão Devices  (Dispositivos) para aceder ao espaço de trabalho Devices

(Dispositivos) do doente.

Os dispositivos podem aparecer na lista com o nome de um dispositivo equivalente.

Consulte Dispositivos suportados na página 2.

4 Localize o dispositivo do qual pretende extrair os dados na lista Active Devices (Dispositivos

activos) e verifique se os dados de Choose port (Escolher porta) estão correctos.

No caso das bombas de insulina, clique no menu pendente Amount of Data (Quantidade de

dados) e seleccione a quantidade de dados da bomba que pretende que o CareLink Pro leia.

5 Clique no respectivo botão READ DEVICE  (Ler dispositivo).

6 Siga as instruções específicas do dispositivo e clique em OK.

7 O CareLink Pro apresenta uma barra de progresso que vai sendo actualizada, de modo a

mostrar a porção da leitura do dispositivo que já foi completada.

Se clicar em CANCEL  (Cancelar) durante a leitura do dispositivo, surge uma mensagem que o

alerta para o facto de um cancelamento da acção poder resultar na perda de todos os dados

lidos até ao momento. Será necessário clicar no botão READ DEVICE  (Ler dispositivo) para

reiniciar o envio.

- Para cancelar, clique em YES (Sim).

- Para continuar a ler os dados do dispositivo, clique em NO  (Não).

Quando o sistema termina a leitura de dados do dispositivo, verá uma mensagem

confirmando que a leitura do dispositivo está completa.

8 Clique em OK.

- No caso das bombas de insulina, siga as instruções para as retirar do modo de

suspensão.

Se o CareLink Pro não conseguir recolher os dados do dispositivo, consulte a secção

Resolução de problemas para obter mais orientações.
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6

Espaço de trabalho Reports (Relatórios)

O software CareLink Pro disponibiliza vários relatórios que ajudam a uma melhor gestão do

tratamento da diabetes dos doentes. As informações incluídas em cada relatório baseiam-se

em dados obtidos a partir dos dispositivos de um doente e da respectiva conta do software

CareLink Personal.

Os relatórios podem ser criados no ecrã, enviados directamente para uma impressora ou

guardados em ficheiros de formato TIFF ou PDF que pode anexar a uma Ficha Médica

Electrónica (Electronic Medical Record ou EMR). É possível criar vários tipos de relatório

através de uma só operação.

Os dados visualizados nestes relatórios são captados a partir dos dispositivos do doente, das

respectivas contas CareLink Personal ou de ambas as formas.

NOTA: O Guia de Consulta dos Relatórios inclui  mais pormenores sobre os componentes

dos relatórios, além de exemplos de relatórios. Pode aceder ao Guia de Consulta dos

Relatórios através do software CareLink Pro, indo até Help>View Report Reference Guide
(PDF) (Ajuda>Ver Guia de Consulta dos Relatórios (PDF)) e seleccionando o idioma

apropriado.
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Antes de começar

Se quiser criar um relatório que abranja os dados de um determinado período de tempo, terá

de recolher os dados do dispositivo do doente referentes a esse período. É ainda necessário

que o dispositivo do doente esteja ligado ao computador para obter os dados actualizados,

antes de elaborar os relatórios.

Estude atentamente a etapa Verificar as configurações do relatório  antes de elaborar um

relatório. Nesta etapa poderá configurar de forma mais precisa um relatório, de modo a captar

os dados do doente que pretende.

Criação de relatórios

As secções seguintes ajudam a compreender melhor os relatórios disponíveis,  bem como o

processo utilizado para a sua criação.

Se estiver familiarizado com o processo de elaboração de relatórios e souber quais os

relatórios que pretende efectuar, pode começar a criar relatórios.

Abrir o espaço de trabalho Reports (Relatórios)

Clique no separador do doente ou clique no botão Open Patient  (Abrir doente)  e faça

duplo clique sobre o nome do doente.

É apresentado o espaço de trabalho Reports  (Relatórios).

NOTA: Para assegurar que tem os dados mais recentes do dispositivo do doente
recolhidos a partir da conta CareLink Personal do doente, clique em SYNC DATA

(Sincronizar dados).

Selecção do período do relatório

1 Para alterar o período de tempo reflectido no(s) relatório(s), clique no menu pendente

Duration  (Duração) e seleccione a duração do período de tempo (A duração máxima é de 12

semanas).

2 As datas de início e fim do período são automaticamente definidas, a não ser que escolha a

opção custom date range  (intervalo de datas personalizado).

NOTA: Se seleccionar um intervalo de datas mais extenso que o permitido, verá uma

mensagem de erro. Ajuste a duração ou as datas.

Se quiser definir um intervalo de datas personalizado, clique nos menus pendentes From

(De) ou Through  (Até) e seleccione o mês, data ou ano pretendidos.
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Data calendar (Calendário de dados)

A área de calendário de dados do espaço de trabalho Reports (Relatórios) mostra uma janela

de três meses de dados para os relatórios.

As barras azuis representam dados do dispositivo. A barra cor-de-laranja representa o período

de elaboração de relatórios que seleccionou. Uma sobreposição dos dados do dispositivo e do

período do relatório significa que dispõe de dados para alguns ou para todos os períodos do

relatório visualizados.

A área do calendário de dados mostra inicialmente os três últimos meses. Para ver outros

meses, clique nos botões com setas  em cada extremidade dos meses.

Seleccionar dados de cada fonte a incluir

1 Se o doente utilizar um medidor de GS que seja possível ligar à sua bomba de insulina, clique

para escolher uma das opções seguintes para elaborar um relatório dos dados de GS deste

medidor:

- In the pump (na bomba): As vantagens desta selecção relacionam-se com o facto de

apenas ter de efectuar a leitura de dados a partir da bomba do doente, de as leituras de

GS virem acompanhadas da respectiva hora atribuída pela bomba de insulina e de as

leituras estarem directamente ligadas a quaisquer cálculos da Ajuda de Bolus utilizados.

Uma desvantagem é a não inclusão no relatório, caso ocorram dificuldades de

comunicação entre a bomba de insulina e o medidor associado, das leituras de GS deste

período problemático. Além disso, para as bombas de insulina MiniMed Paradigm

anteriores à 522/722, todas as leituras de GS relacionadas com os cálculos da Ajuda de

Bolus que não sejam objecto de reacção, não são incluídas no relatório.

- In the link meter(s) (No(s) medidor(es) ligado(s)):  a vantagem desta selecção é o facto de

todas as leituras guardadas no medidor ligado serem incluídas no relatório. A

desvantagem relaciona-se com o facto de ser obrigatória a sincronização prévia dos

relógios da bomba de insulina e do medidor para que seja possível correlacionar os

dados do medidor e os dados da bomba de insulina. Tem ainda de efectuar a leitura

separada dos dados da bomba e do medidor associado.

2 Para adicionar os dados do dispositivo aos relatórios, seleccione a caixa de verificação ao

lado do dispositivo em questão.

Não pode adicionar dispositivos que tenham sido excluídos devido à sua selecção na etapa 1.

Para alterar esta situação, seleccione a outra opção do medidor associado.
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3 Para excluir os dados do dispositivo dos relatórios, anule a selecção da caixa de verificação ao

lado do dispositivo em questão.

Não pode anular a selecção das caixas de verificação relacionadas com a opção seleccionada

na etapa 1. Para alterar esta situação, seleccione a outra opção do medidor associado.

Verificar os dados do dispositivo

1 Observe a área do calendário no espaço de trabalho Reports (Relatórios) para ver se a barra

cor-de-laranja, que representa o período abrangido pelo relatório, se sobrepõe às barras

azuis que representam os dados do dispositivo.

2 Se as barras se sobrepuserem durante todo o período abrangido pelo relatório, tem dados

para criar o(s) relatório(s). Pode clicar em NEXT  (Seguinte) e passar a Verificação das

configurações dos relatórios na página 43.

3 Se as barras não se sobrepuserem ou se não se sobrepuserem o suficiente, tem algumas

opções:

- ajustar o período abrangido pelo relatório;

- obter dados adicionais do dispositivo.

Obter dados adicionais do dispositivo

1 Para obter mais dados de um dispositivo, clique no botão READ DEVICE  (Ler dispositivo)

associado ao dispositivo.

Surge a barra Read Device (Ler dispositivo).

AVISO: Cancele ou termine todos os bolus activos e índices basais temporários e limpe
todos os alarmes activos. O funcionamento da bomba de insulina será suspenso

durante a leitura. Completada a leitura, verifique se a bomba retomou o

funcionamento.

ATENÇÃO: Não use o controlo remoto da bomba de insulina durante a leitura da

bomba. Se a pilha da bomba de insulina estiver fraca, a bomba não enviará dados

para o PC. Substitua a pilha se o ecrã de estado do dispositivo indicar que a energia
da pilha está fraca.

2 Verifique se os dados do campo Choose port  (Escolher porta) são os correctos para este

dispositivo.
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Para alterar esta configuração, clique no menu pendente do campo e seleccione uma

configuração diferente.

3 Assegure-se de que o dispositivo está ligado ao computador.

4 Se o dispositivo for uma bomba de insulina, pode especificar a quantidade de dados que

pretende obter do mesmo. Clique no menu pendente Amount of Data  (Quantidade de

dados) e seleccione uma quantidade.

NOTA: Se seleccionar All available data (Todos os dados disponíveis),  o sistema lê
todos os dados na bomba de insulina. Esta acção sobrepõe a gravação a todos os

dados duplicados presentes no sistema.

5 Clique em READ DEVICE  (Ler dispositivo). Leia atentamente a mensagem que surge no ecrã,

uma vez que fornece instruções específicas para a leitura da bomba de insulina.

6 Siga as instruções e clique em OK.

Surge a barra de progresso Read Device (Ler dispositivo).

Pode optar por cancelar a leitura em qualquer altura, clicando em CANCEL  (Cancelar).

Surge uma mensagem, confirmando que a leitura está completa.

7 Clique em OK.

Os dados do dispositivo são agora visíveis no calendário de dados.

8 Clique em NEXT (Seguinte) no topo do espaço de trabalho Reports (Relatórios).

É visualizada a etapa Verify Reports Settings (Verificar configurações do relatório). Esta etapa

permite assegurar que as configurações deste doente estão correctas antes de elaborar o(s)

relatório(s).

Verificação das configurações dos relatórios

1 Assegure-se de que as configurações de Glucose Target (Objectivo de glicemia) estão nos

valores pretendidos. Digite estes valores ou clique nas setas ascendente ou descendente nos

campos Low  (Inferior) e High  (Superior) para elevar ou baixar os valores.

NOTA: São apresentados marcadores de leitura do medidor (||  |)  na linha temporal
entre o despertar e o deitar,  bem como na linha temporal dos marcadores de

refeição. Na medida em que alguns relatórios se baseiam em dados encontrados em

tempos de refeição definidos, ou de horas de despertar ou deitar, é importante que os
marcadores de eventos da Ajuda de Bolus e de leitura do medidor sejam agrupados

de forma correcta.

2 Para adicionar um novo período de refeição, clique em ADD MEAL  (Adicionar refeição). Para

editar um período de refeição existente, clique em qualquer ponto de um período de

refeição disposto na linha de tempo.
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O editor Meal Period (Períodos de refeição), localizado por baixo da linha de tempo, fica

activo.

NOTA: Pode ter cinco períodos de refeição, no máximo. Os períodos predefinidos são

pequeno-lamoço, almoço e jantar.

3 Digite texto ou clique nas setas para seleccionar as configurações pretendidas.

Se apenas quiser usar estas configurações para esta refeição, limpe a caixa de verificação Use

these parameters for all of this patient's meals  (Usar estes parâmetros para todas as

refeições deste doente).

- Meal Name (Nome da refeição): nome que pretende atribuir ao período de refeição.

- Meal Time Period (Período de tempo da refeição): horas entre as quais decorre a

refeição.

- Pre-Meal BG Target (mg/dL or mmol/L) (Objectivo de GS antes da refeição (mg/dl ou

mmol/l): limites inferior e superior dos objectivos de glicemia do doente antes da

refeição.

- Pre-Meal Analysis Period  (Período de análise antes da refeição): período de tempo em

que a glicose será analisada antes do início de uma refeição. As leituras de glicose

captadas durante este período são usadas na análise dos relatórios exaustivos.

- Post-Meal BG Target (mg/dL or mmol/L)  (Objectivo de GS após a refeição (mg/dl ou

mmol/l): limites inferior e superior dos objectivos de glicemia do doente após a refeição.

- Post-Meal Analysis Period (Período de análise após a refeição): período de tempo em

que a glicose será analisada após uma refeição. As leituras de glicose captadas durante

este período são usadas na análise dos relatórios exaustivos.

É possível alterar a duração de um período de refeição estabelecido ou de um período

“ao acordar” e “ao deitar”, clicando nos ponteiros de início ou de fim e arrastando e

largando os ponteiros ao longo da linha de tempo.

NOTA: Os períodos das refeições não podem sobrepor-se, embora as linhas de início e

de fim possam tocar-se. Os períodos das refeições têm de ter uma duração mínima de
60 minutos.

4 Para utilizar a configuração desta refeição em todas as outras refeições do doente, verifique

se a caixa de verificação ao lado de Use these parameters for all of this patient’s meals
(Utilizar estes parâmetros em todas as refeições deste doente) se encontra seleccionada.

5 Depois de ter criado ou editado um período de refeição, clique em SAVE  (Guardar).

6 Para remover um período de refeição, clique em DELETE MEAL  (Eliminar refeição). Clique em

DELETE (Eliminar) quando lhe for pedido para confirmar.

7 O CareLink Pro conservará em memória estas configurações particulares até à próxima vez

que elaborar um relatório para o mesmo doente. Para as guardar associadas a este doente,

clique em SAVE SETTINGS  (Guardar configurações).
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8 Clique em NEXT (Seguinte) no topo do espaço de trabalho Reports (Relatórios).

Esta é a etapa de selecção e elaboração de relatórios do processo. Fornece uma lista de tipos

de relatórios, além de uma Tabela de Dados que o ajuda a incluir ou excluir os dados de

determinados dias do(s) relatório(s) Daily Detail (Diários exaustivos).

NOTA: Para alterar a visualização de Data Table (Tabela de dados), clique em

>>customize columns (Personalizar colunas).  Consulte Preferências para a criação de

relatórios na página 18.

9 Para imprimir o ecrã, clique no ícone PRINT (Imprimir) .

Selecção de tipos de relatórios e datas de inclusão

1 Seleccione a caixa de verificação ao lado do(s) relatório(s) que pretende incluir no conjunto

de relatórios.

2 Se tiverem sido lidos dados de uma bomba de insulina ou monitor Guardian mais que uma

vez durante este período abrangido pelo relatório, é possível que existam várias perspectivas

do dispositivo:

a. Verifique se a caixa de verificação ao lado de Device Settings Snapshot (Perspectiva das

configurações do dispositivo) se encontra seleccionada.

b. Clique na seta pendente e seleccione uma data e hora para a perspectiva.
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- Bombas de insulina: Seleccione uma perspectiva da bomba de insulina do doente.

- Guardian:  Seleccione uma perspectiva do monitor Guardian do doente.

Se um dos campos se apresentar esbatido, não existem perspectivas disponíveis durante o

período do relatório.

3 Percorra a Data Table (Tabela de dados) para rever as informações disponíveis para o

relatório Daily Detail (Diário exaustivo).

- Pode ordenar os dados de cada coluna. Clique no cabeçalho da coluna para ordenar os

dados em ordem ascendente. Clique no cabeçalho de novo para ordenar os dados em

ordem descendente.

NOTA: Se não existirem dados para uma determinada data, esta última não poderá
ser seleccionada.

4 Seleccione a caixa de verificação nas linhas da tabela de dados para qualquer data que

pretenda ver reflectida num relatório Daily Detail (Diário exaustivo).

- Para incluir ou excluir todas as datas do relatório Daily Detail (Diário exaustivo) com um

clique, seleccione a caixa de verificação no topo da coluna das caixas de verificação Data

Table (Tabela de dados).

Elaboração de relatórios

1 Depois de verificar as selecções de relatórios, clique em GENERATE REPORTS (Criar

relatórios) no topo do espaço de trabalho Reports  (Relatórios).

Surge uma lista de opções.

2 Seleccione uma opção para pré-visualizar, imprimir ou guardar o(s) relatório(s).

Se tiver seleccionado Preview  (Pré-visualização), surge a janela Preview.

3 Clique nos botões com setas para navegar nos relatórios com várias páginas.

4 Clique num dos outros botões no tipo da janela Preview  (Pré-visualização) para guardar ou

imprimir o(s) relatório(s).

5 Para fechar esta janela, clique no botão Close  (Fechar)  no canto superior direito da janela.

Acerca dos relatórios

Este tópico contém uma descrição de cada relatório. O Guia de Consulta dos Relatórios inclui

mais pormenores sobre os componentes dos relatórios, além de exemplos de relatórios. Pode

aceder ao Guia de Consulta dos Relatórios através do software CareLink Pro:

1 Help > View Report Reference Guide (PDF)  (Ajuda > Ver Guia de Consulta dos Relatórios

(PDF)).

2 Seleccione um idioma para o Guia de Consulta dos Relatórios.
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Os relatórios do CareLink Pro têm em comum os seguintes elementos:

• Cabeçalho do relatório  — O cabeçalho do relatório inclui dados identificativos, como o

nome do relatório, o nome do doente e a origem dos dados.

• Carbohidratos e níveis de glicemia  — Dentro dos gráficos e tabelas, as unidades de

carbohidratos são visualizadas em itálico e os níveis de glicemia são visualizados a negrito.

• Dados de fim-de-semana — Os dias do fim-de-semana apresentam-se a negrito para que

possa identificá-los facilmente.

• Legendas  — Aparece uma legenda dos símbolos ao fundo de cada relatório. Embora um

simbolo possa ser usado em vários relatórios, as legendas são específicas de cada relatório.

Relatório de adesão

O Relatório de adesão apresenta dados que descrevem como as bombas de insulina e os

sensores são usados e ainda os comportamentos do doente relevantes para a terapia.

Respondem à pergunta, “Existem dados suficientes para facultar uma imagem rigorosa da

forma como o doente utiliza a sua bomba de insulina e sensor, se for o caso?” Respondem

ainda à pergunta, “Os doentes respeitam a terapia, conforme as instruções recebidas?”

Indicam ainda se terá de falar com o doente sobre a forma como está a gerir a sua diabetes.

Relatório Perspectiva geral do sensor e medidor de glicose

O relatório Perspectiva geral do sensor e medidor de glicose fornece uma representação

gráfica das médias e dos níveis diários de glicemia recolhidos com sensor e medidor por um

doente, decompostos por hora ao longo de 24 horas e relacionados com as refeições e

padrões de sono. São ainda incluídas as estatísticas de utilização de insulina e das leituras de

glicemia do doente.

É elaborada uma análise semelhante dos dados do sensor na primeira página deste relatório,

se existirem dados de sensor disponíveis.  Quando não existirem dados disponíveis sobre o

sensor, a página de análise de dados do medidor aparecerá como a primeira página.

A(s) página(s) final/finais do relatório mostra(m) o nível e qualidade diária do controlo

glicémico, de carbohidratos e insulina do doente. Cada página mostra como esse controlo

varia em cada dia, ao longo de todo o período abrangido pelo relatório até um máximo de 14

dias por página.

Relatório Logbook

O relatório Logbook (Livro de registo) inclui dados relativos à insulina, carbohidratos e

glicemia do medidor de glicose para cada dia do período abrangido pelo relatório. Fornece

um diário de eventos registados por hora, além de totais e médias diárias. Cada página

contém até 14 dias. Se o período abrangido pelo relatório ultrapassar 14 dias, são criadas

páginas adicionais.
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Perspectiva das configurações do dispositivo

O relatório Perspectiva das configurações do dispositivo apresenta uma perspectiva das

configurações da bomba de insulina ou monitor Guardian REAL-Time do doente em relação a

uma data e hora específicas. Isto pode ajudar a interpretar outros relatórios ou pode

simplesmente documentar as configurações do doente.

As configurações da bomba de insulina ou monitor são registadas apenas quando é efectuada

a leitura do dispositivo. Se não for efectuada uma leitura do dispositivo durante o período

abrangido pelo relatório, não ficarão disponíveis quaisquer configurações.

Relatório diário exaustivo

O relatório diário exaustivo apresenta os dados de glicemia, quantidades de carbohidratos e a

utilização da insulina pelo doente para o dia seleccionado. É elaborado um relatório separado

para cada dia seleccionado na Data Table (Tabela de dados).

O relatório diário exaustivo contém uma perspectiva detalhada de cada dia seleccionado.

Permite-lhe concentrar-se num dia em particular,  se achar que ocorreu algo de interesse para

a terapia do doente.

Exportar dados

É possível exportar dados do dispositivo captados e guardados pelo CareLink Pro. Assim,

dispõe de todos os dados do dispositivo de um doente para utilizar como estatísticas ou na

criação de tabelas ou relatórios especializados. O ficheiro .csv pode ser importado para o

Microsoft Excel ou determinados programas de estatísticas clínicas onde os respectivos dados

podem ser tratados.

O ficheiro .csv contém dados que registam as acções do dispositivo. Por exemplo, enumera o

registo das leituras do medidor de glicose, a recepção do valor da leitura do medidor pela

bomba de insulina ou a alteração do índice basal.

NOTA: Esta é uma função avançada e exige que se familiarize com os dados não tratados

do dispositivo. É ainda necessário que tenha bastante experiência na utilização do
software para o qual vai importar o ficheiro .csv.

Siga estas etapas para utilizar a função de exportação do CareLink Pro:

1 Clique no separador do doente ou clique no botão Open Patient  (Abrir doente)  e faça

duplo clique sobre o nome do doente.

2 Assegure-se de que o espaço de trabalho Reports  (Relatórios) está aberto.

3 Use os campos Duration (Duração) ou From/Through  (De/Até) para definir as datas e a

duração do relatório.

A duração máxima que é possível seleccionar é de 12 semanas.

4 Clique na hiperligação export selected data  (Exportar dados seleccionados).
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Surge a caixa de diálogo Export Data to CSV File (Exportar dados para ficheiro CSV).

5 Navegue até à localização do seu computador em que pretende guardar o ficheiro .csv. Se

pretender mudar o nome do ficheiro, digite-o na caixa File name (Nome do ficheiro).

6 Clique no botão SAVE (Guardar).

NOTA: Para mais informações sobre os dados visualizados nos ficheiros CSV, consulte

o apêndice de dados CSV.

O ficheiro .csv fica guardado no computador, no local seleccionado. Pode agora importá-lo

para qualquer programa que suporte este tipo de ficheiro.
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7

Administração do sistema

É importante efectuar regularmente cópias de segurança da base de dados do CareLink Pro. A

base de dados guarda todos os dados do sistema que tenham vindo a acumular-se nos

registos do doente, incluindo os dados do perfil,  os dados recolhidos no dispositivo e as

configurações dos relatórios.

É também importante que disponha da versão mais recente do CareLink Pro. As versões

actualizadas são disponibilizadas periodicamente e podem conter melhorias importantes.

Pode optar por procurar actualizações ou ser avisado da sua disponibilização.

Aplicar actualizações de software

Estarão disponíveis actualizações ocasionais do software CareLink Pro. Quando surgir um

aviso de uma actualização, proceda da seguinte forma para transferir a última versão do

software.

NOTA: Efectue uma cópia de segurança da base de dados antes de instalar uma

actualização do software. Consulte Efectuar cópias de segurança da base de dados na

página 52.

1 Verifique se dispõe de uma ligação activa à Internet no computador.

2 A mensagem CareLink Pro Update (Actualização do CareLink Pro) surge quando existe uma

actualização ao CareLink Pro. Esta mensagem permite-lhe optar por transferir a actualização.

3 Clique em DOWNLOAD  (Transferir) (Se clicar em CANCEL  (Cancelar), a notificação de

actualização será encerrada. Poderá transferir a actualização mais tarde).

Surge uma mensagem de aviso que recomenda a realização de uma cópia de segurança da

base de dados.

4 Clique em YES  (Sim) para criar uma cópia de segurança da base de dados (consulte Efectuar

cópias de segurança da base de dados na página 52  para obter mais informações sobre este

procedimento). Clique NO (Não) se já tiver criado uma cópia de segurança dos dados.
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Surge uma mensagem, confirmando que a nova versão do CareLink Pro foi transferida.

5 Para começar a utilizar a versão mais recente do CareLink Pro, clique em YES  (Sim) para

encerrar e abrir de novo a aplicação de software. Clique em NO (Não) se preferir aguardar

para reiniciar o CareLink Pro.

Desactivar as actualizações automáticas

Se não pretender receber notificações automáticas das actualizações do CareLink Pro, siga estas

etapas:

1 Seleccione Tools > Options  (Ferramentas > Opções).

2 Clique no separador General (Geral).

3 Na secção Communications (Comunicações), limpe a caixa de verificação ao lado de

Automatically check for software updates  (Verificar automaticamente as actualizações de

software).

Verificação manual de actualizações

Pode verificar manualmente se existem actualizações do CareLink Pro, em qualquer altura.

NOTA: Efectue uma cópia de segurança da base de dados antes de instalar uma

actualização do software. Consulte Efectuar cópias de segurança da base de dados na

página 52.

1 Verifique se dispõe de uma ligação activa à Internet no computador.

2 Seleccione Tools > Check for Software Updates  (Ferramentas > Verificar actualizações do

software).

3 Receberá uma mensagem se não existirem actualizações disponíveis no momento. Se existir

uma actualização, surge uma mensagem de CareLink Pro Update (Actualização do CareLink

Pro).

4 Siga o procedimento descrito em Aplicar actualizações de software na página 50.

Criar cópias de backup e restabelecer a base de dados

É aconselhável estabelecer um plano regular para a realização de cópias de segurança. Tal

garantirá a regularidade da realização de cópias de segurança e reduzirá o risco de perda de

dados.

Se estiver a efectuar uma cópia de segurança da base de dados ou a restaurá-la, o sistema

apresenta uma mensagem de alerta caso existam utilizadores activos do software noutros

computadores.
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Efectuar cópias de segurança da base de dados

As seguintes etapas permitem-lhe efectuar cópias de segurança da actual base de dados, em

local a seleccionar.

1 Certifique-se que todos os registos dos doentes estão fechados.

2 Seleccione Tools > Backup Database  (Ferramentas > Efectuar cópia de segurança da base

de dados).

NOTA: As cópias de segurança da base de dados podem ser guardadas numa unidade

de rede ou num suporte amovível de armazenamento de dados (como um DVD, CD ou
unidade USB).

3 Navegue até à localização do seu computador em que pretende guardar o ficheiro de cópia

de segurança. Se pretender mudar o nome do ficheiro de segurança, digite-o na caixa File

name (Nome do ficheiro).

4 Clique no botão Save  (Guardar). É visualizada uma barra de progresso enquanto a base de

dados é guardada.

Surge uma mensagem quando a cópia de segurança estiver completa.

5 Clique em OK para fechar a mensagem.

Restaurar a base de dados

A actual base de dados pode ter de ser substituída se depois não for possível aceder à

mesma ou usá-la. Quanto mais actual for a cópia de segurança, menos dados se perderão se

substituir a base de dados.

ATENÇÃO: Ao restaurar a base de dados a partir de uma cópia de segurança, perde todos
os novos dados criados na base de dados actual,  desde que efectuou a cópia de

segurança seleccionada.

As seguintes etapas permitem-lhe seleccionar uma cópia de segurança para substituir a actual

base de dados.

1 Certifique-se que todos os registos dos doentes estão fechados.

2 Seleccione Tools > Restore Database (Ferramentas > Restaurar base de dados).

3 Seleccione o ficheiro de segurança que pretende usar para substituir a actual base de dados

(habitualmente, o mais recente).

4 Clique em Open  (Abrir). Surge uma mensagem de aviso relativa aos dados que podem ser

perdidos se continuar com a operação de restauro.

5 Para continuar, clique em OK.  É visualizada uma barra de progresso enquanto a base de

dados está a ser restaurada.

Surge uma mensagem quando a base de dados estiver restaurada.
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6 Clique em OK para fechar a mensagem.

Quando o sistema está indisponível

Se tentar inicializar o sistema enquanto outro utilizador estiver a criar uma cópia de segurança

ou um restauro, receberá uma mensagem com a notificação de que o sistema não está

disponível.  Não conseguirá aceder ao sistema até a tarefa estar concluída.

Efectue uma das seguintes acções:

• aguarde que o processo termine e que o sistema fique disponível;

• clique em CANCEL  (Cancelar) para sair e tentar de novo mais tarde.
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Resolução de problemas

Este tópico foi concebido para o ajudar a resolver problemas que possam ocorrer durante a

utilização do software CareLink Pro. Também contém instruções para desinstalar o software

CareLink Pro, se necessário.

Erros gerais na utilização da aplicação

Se tentar transferir uma actualização de software da Internet, pode receber uma mensagem

indicando que não tem a necessária autorização para o fazer. É preciso ter o estatuto de

administrador no sistema para transferir as actualizações do software CareLink Pro.

1 Encerre a aplicação de software CareLink Pro e reinicie o seu computador.

2 Peça a uma pessoa com estatuto de administrador para iniciar uma sessão no computador.

3 Siga as instruções de Aplicar actualizações de software na página 50.

Not connected to the database (Não está ligado à base de dados)

Uma mensagem de erro informando que não se encontra ligado à base de dados indica um

dos seguintes problemas:

• A base de dados foi deslocada. A base de dados tem de estar no mesmo local que foi

seleccionado durante a instalação do software CareLink Pro. Se tiver sido deslocada, tem de

ser novamente colocada no local seleccionado durante a instalação.

• Não está ligado à unidade de rede onde está localizada a base de dados. Se a base de dados

estiver localizada numa unidade de rede, é possível que ocorram ocasionalmente problemas

na rede que impeçam o acesso à unidade. Contacte o seu departamento de informática para

que o ajudem a restabelecer a ligação à unidade de rede onde está localizada a base de

dados.
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Esqueceu-se da palavra-passe do médico para aceder ao CareLink Pro

Se ninguém se lembrar da palavra-passe do médico para iniciar uma sessão no CareLink Pro,

será necessário reinstalar o software CareLink Pro e criar uma nova base de dados. Uma vez

reinstalado o software, não conseguirá aceder a quaisquer informações de doentes que se

encontravam na base de dados anterior.  Guarde a palavra-passe criada durante a nova

instalação num local do escritório para que não perca dados futuros.

Erros na leitura de dispositivos

Erro Explicação

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is  available, or select another port.
(Não foi possível abrir a porta série seleccionada. Pode
estar em curso outra operação nessa porta. É favor
aguardar até a porta ficar disponível ou seleccionar
outra porta.)

Verifique se a porta de comunicação seleccionada
não está a ser usada por outro programa ou
seleccione outra porta. Experimente reiniciar o
computador que está a utilizar e tentar novamente
efectuar a leitura do dispositivo. O hardware (como
o cabo) de ligação à porta ou a própria porta
podem estar danificados. Ligue o hardware a outra
porta e tente novamente efectuar a leitura do
dispositivo para ajudar a determinar o problema.

Auto Detect could not find the device on any available
port. Please check the cable connection, device battery
& status and try again, or try specifying a serial port. (A
detecção automática não conseguiu localizar o
dispositivo numa porta disponível. Deve verificar a
ligação do cabo, a pilha e o estado do dispositivo e
tentar de novo ou tentar especificar uma porta série.)

Verifique a ligação entre o cabo e o PC e verifique o
bom estado da bateria do dispositivo. Se estiver em
bom estado, experimente especificar a porta série
do PC à qual o cabo está ligado, em vez de
seleccionar a detecção automática.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Dispositivo não encontrado na porta
série seleccionada. Deve verificar a ligação por cabo, a
pilha e o estado do dispositivo e tentar de novo ou
tentar efectuar a detecção automática do dispositivo.)

Verifique a ligação entre o cabo e o PC e verifique o
bom estado da bateria do dispositivo. Se estiver em
bom estado, experimente seleccionar um número
de porta série diferente no PC ou escolher a opção
de detecção automática.

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and try
again. (Não foi possível comunicar com o dispositivo. É
favor verificar se fixou e seleccionou o dispositivo
correcto, verificar a ligação por cabo, o estado e a pilha
do dispositivo e tentar de novo.)

Verifique todas as configurações seleccionadas para
a leitura do dispositivo, incluindo o nome do
dispositivo, número de série e tipo de ligação.
Verifique ainda se o dispositivo, o cabo e o PC
estão devidamente ligados. Verifique se a pilha e o
estado do alarme do dispositivo se encontram em
boas condições. Tente novamente efectuar a
leitura.

Unexpected response...  retrying (n%) (Resposta
inesperada...  a tentar de novo (n%))

Foi lido um valor inesperado no dispositivo. O
sistema tenta uma nova comunicação até o
utilizador cancelar esta acção ou até a comunicação
ter êxito.

The link device was found, but the device (<serial #>) is
not responding. Please verify the device’s serial
number, place the device closer to the link device to
minimize signal interference, check device battery and
status. (O dispositivo de ligação foi localizado mas o
dispositivo (n.º de série) não está a responder. Deve
verificar o número de série do dispositivo, aproximar o
dispositivo ao dispositivo de ligação para minimizar a
interferência de sinal,  verificar a pilha e o estado do
dispositivo.)

Verifique se foi introduzido o número de série
correcto. Se não tiver sido introduzido o número
correcto, reintroduza o número de série correcto.
Se o número de série estiver correcto, tente
aproximar o dispositivo de ligação do dispositivo
de comunicação. Afaste o dispositivo de ligação e o
dispositivo de comunicação de possíveis fontes de
interferência (tais como outros dispositivos de RF).
Verifique a potência da pilha do dispositivo e, se
estiver a enviar uma bomba de insulina, verifique o
estado de administração da bomba.
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Erro Explicação

This pump is delivering a temp basal. Please cancel the
temp basal or wait until it completes, and then try
again. (Esta bomba de insulina está a administrar um
índice basal temporário. É favor cancelar o índice basal
temporário ou aguardar até que o mesmo se complete e
tentar de novo.)

A bomba de insulina na qual está a tentar efectuar
a leitura está a administrar um índice basal
temporário. Aguarde o final  da administração do
índice basal temporário para efectuar a leitura da
bomba ou cancele o índice basal temporário e
efectue depois a leitura.

This device has active errors or alarms. Please clear the
alarms and try again. (Esta bomba de insulina tem erros
ou alarmes activos. É favor eliminar os alarmes e tentar
de novo.)

Existem alarmes activos na bomba de insulina que
impedem a leitura.  Leia as instruções sobre alarmes
para apagar o alarme. Apague o alarme e tente
efectuar novamente a leitura da bomba.

This pump is delivering a bolus. Please cancel the bolus
or wait until it completes, and then try again. (Esta
bomba de insulina está a administrar um bolus. É favor
cancelar o bolus ou aguardar até que o mesmo se
complete e tentar de novo.)

A bomba de insulina na qual está a tentar efectuar
a leitura está a administrar um bolus. Aguarde o
final  da administração do bolus para efectuar a
leitura da bomba ou cancele o bolus e efectue
depois a leitura.

The device returned invalid entries; all data read will be
discarded. (O dispositivo enviou entradas inválidas;
todos os dados lidos serão eliminados.)

Contacte o seu representante local (consulte
Assistência na página 2).

Erros na criação de relatórios

Multiple data entries for the same date (Várias entradas de dados para a mesma data)

Se um só dispositivo apresentar várias entradas de dados para a mesma data e hora, o sistema

considera que existe um conflito insolúvel.  Os relatórios criados com os dados deste

dispositivo omitirão a porção de dados sobrepostos.

Pode tentar ajustar o período abrangido pelo relatório para evitar os dados sobrepostos. Ou

pode retirar o dispositivo do sistema e adicioná-lo de novo para apagar as leituras anteriores.

System is going to ignore data (O sistema vai ignorar os dados)

Se a hora num dispositivo tiver sido alterada, causando sobreposições ou lacunas nos dados

com duração igual ou superior a três horas, o sistema não inclui essa porção de dados ao criar

relatórios.

Erros relativos a cópias de segurança e restauros

The database cannot be locked (Não é possível bloquear a base de dados)

Isto significa que está a usar o sistema num ambiente com vários utilizadores no qual existem

outros utilizadores com uma sessão iniciada. O sistema não permite que se efectue uma cópia

de segurança da base de dados enquanto outros utilizadores estiverem a realizar tarefas que

possam afectar a base de dados. Depois que todos os utilizadores saírem do CareLink Pro,

poderá proceder à cópia de segurança da base de dados.

A database backup or restore is not completing (Uma cópia de segurança ou restauro da
base de dados não está a ser completado)

Outros utilizadores não podem iniciar sessão e a cópia de segurança ou restauro não se

completam. Contacte o seu representante local (consulte Assistência na página 2).
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A restore database fails (O restauro da base de dados falhou)

O ficheiro com a cópia de segurança da base de dados que está a tentar utilizar no processo

de restauro está corrompido. Tente proceder ao restauro com outro ficheiro de cópia de

segurança.

Desinstalar o software

Se precisar de desinstalar o CareLink Pro, complete as seguintes etapas:

1 Abra o Painel de controlo através do menu Start (Iniciar) do Windows.

2 Seleccione Add or Remove Programs  (Adicionar ou remover programas). Abre-se a janela

de Adicionar ou remover programas do Windows.

3 Percorra a lista até Medtronic CareLink Pro  e clique neste nome.

4 Clique em Remove  (Remover). Surge o Assistente Install Shield.

5 Clique em Next  (Seguinte). Surge uma mensagem pedindo-lhe que confirme se pretende

remover a aplicação.

6 Clique em Yes  (Sim). O programa de desinstalação é executado e remove o programa e

respectivos ficheiros do seu computador. No final do processo, surge uma mensagem no

ecrã do Assistente confirmando a desinstalação.

7 Clique em Finish  (Terminar).
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Tabela de ícones

Os ícones e símbolos dos rótulos da embalagem e do equipamento são descritos na tabela

seguinte:

Descrição Ícone

Um por contentor/embalagem (1X)

CD incluído

Atenção: Ler todos os avisos e precauções nas instruções
de utilização.

Data de fabrico (ano)

Número de catálogo

Conformité Européenne (Conformidade Europeia). Este
símbolo significa que o dispositivo está em total
conformidade com a Directiva Europeia 93/42/CEE
relativa a dispositivos médicos e Directiva R&TTE 1999/5/
CE.
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Dados CSV

Ao exportar dados de relatório a partir do software CareLink Pro, esses dados são exportados

para um ficheiro .csv. Este ficheiro pode ser posteriormente importado para uma aplicação de

folha de cálculo, como o Microsoft Excel. Consulte as definições de coluna do ficheiro CSV

para obter uma listagem completa dos dados que podem ser incluídos num ficheiro CSV.

O ficheiro CSV contém o nome e o ID de doente do doente, o período de criação de relatórios

e identifica cada dispositivo incluído no relatório.

Definições dos dados das colunas

Cabeçalho da coluna Definição

Index (Índice remissivo) A ordem pela qual os dados foram gravados no
dispositivo.

Date (Data) A data na qual os dados foram gravados no
dispositivo.

Time (Hora) A hora à qual os dados foram gravados no
dispositivo.

New Device Time (Nova hora do dispositivo) A nova hora e data, se estas tiverem sido alteradas
no dispositivo.

BG Reading (mg/dL or mmol/L) (Leitura GS (mg/dl ou
mmol/l))

A leitura da glicose no sangue registada pelo
medidor, pelo Guardian ou pela bomba. Se os dados
forem provenientes de uma bomba ou do Guardian,
esta coluna reflecte as GS manuais e as GS recebidas
de um medidor ligado.

Linked BG Meter ID (ID de medidor de GS ligado)
Número de série do medidor de glicose no sangue
que envia uma leitura da glicemia específica para o
dispositivo.

Basal  Rate (U/h) (Índice basal (U/h)) O índice de administração de insulina basal activa em
unidades por hora.

Temp Basal Amount (Quantidade do índice basal
temporário)

Se tiver sido aplicado um índice basal temporário na
bomba, este valor representa a quantidade do índice
basal temporário.

Temp Basal Type (Tipo de basal temporário) O tipo de ajuste do índice basal temporário (índice
de insulina ou percentagem de basal).

CareLink Pro Guia do utilizador   Dados CSV 59



Cabeçalho da coluna Definição

Temp Basal Duration (m) (Duração do índice basal
temporário (m))

A duração em minutos da administração da insulina
basal temporária (consulte o tipo acima referido).

Bolus Type (Tipo de bolus)
Tipo de administração de insulina de bolus [Normal,
Quadrada, Dupla (parte normal),  ou Dupla (parte
quadrada)].

Bolus Volume Selected (U) (Volume de bolus
seleccionado (U))

Número de unidades de insulina seleccionadas para
administração durante a administração da insulina de
bolus.

Bolus Volume Delivered (U) (Volume de bolus
administrado (U))

Número de unidades de insulina efectivamente
administradas durante a administração da insulina de
bolus.

Programmed Bolus Duration (h) (Duração programada
do bolus (h))

Duração de um bolus quadrado ou da porção
quadrada de um bolus de onda dupla.

Prime Type (Tipo de enchimento)

Manual ou fixo. O manual é usado imediatamente
após uma rebobinagem, para encher o cateter de
infusão com insulina antes de o inserir.  O fixo é
usado após a inserção do cateter de infusão, para
encher a cânula maleável com insulina após a
remoção da agulha introdutora.

Prime Volume Delivered (U) (Volume de enchimento
administrado (U))

Número de unidades de insulina efectivamente
administradas durante o enchimento

Alarm (Alarme) Nome do alarme ocorrido.

Suspend (Suspender) Identifica o estado de suspensão da bomba.

Rewind (Rebobinar) Data e hora em que o dispositivo foi rebobinado.

BWZ Estimate (U) (Estimativa da Ajuda de Bolus (U))
A estimativa da insulina de bolus calculada pela
função Ajuda de Bolus da bomba de insulina
Paradigm.

BWZ Target High BG (mg/dL or mmol/L) (Objectivo
superior de GS da Ajuda de Bolus (mg/dl ou mmol/l))

Configuração do limite superior do intervalo de
objectivos de glicemia, utilizado pela função Ajuda
de Bolus.

BWZ Target Low BG (mg/dL or mmol/L) (Objectivo
inferior de GS da Ajuda de Bolus (mg/dl ou mmol/l))

Configuração do limite inferior do intervalo de
objectivos de glicemia, utilizado pela função Ajuda
de Bolus.

BWZ Carb Ratio (Taxa de carbohidratos da Ajuda de
Bolus)

Configuração para a taxa de carbohidratos/insulina.
Se as unidades usadas forem gramas, a taxa é o
número de gramas compensados por uma unidade
de insulina. Se as unidades usadas forem porções, a
taxa é o número de unidades de insulina utilizadas
para compensar uma porção de carbohidratos.

BWZ Insulin Sensitivity (Sensibilidade à insulina da
Ajuda de Bolus)

Configuração da sensibilidade à insulina. A
sensibilidade à insulina é a quantidade da redução
do nível de glicemia conseguida com uma unidade
de insulina. Esta é utilizada pela função Ajuda de
Bolus.

BWZ Carb Input (Entrada de carbohidratos da Ajuda
de Bolus)

Quantidade de carbohidratos introduzida na Ajuda
de Bolus e utilizada para estimar um bolus.

BWZ BG Input (mg/dL or mmol/L) (Entrada de GS da
Ajuda de Bolus (mg/dl ou mmol/l))

Leitura da glicemia quando introduzida na Ajuda de
Bolus e utilizada para estimar um bolus.

BWZ Correction Estimate (U) (Estimativa de correcção
da Ajuda de Bolus (U))

Unidades de insulina de bolus a administrar para
corrigir o nível de glicemia, conforme os cálculos da
função Ajuda de Bolus.

BWZ Food Estimate (U) (Estimativa de alimentos da
Ajuda de Bolus (U))

Estimativa de unidades de insulina de bolus a
administrar para compensar as previsões de consumo
de carbohidratos, conforme os cálculos da função
Ajuda de Bolus.
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Cabeçalho da coluna Definição

BWZ Active Insulin (U) (Insulina activa da Ajuda de
Bolus (U))

Cálculo da quantidade de insulina activa proveniente
de administrações anteriores de insulina de bolus e
ainda presente no organismo, ao determinar a
estimativa da quantidade de bolus através da função
Ajuda de Bolus.

Sensor Calibration BG (mg/dL or mmol/L) (GS de
calibração do sensor (mg/dl ou mmol/l))

O valor de GS usado para calibrar o sensor em mg/
dl ou mmol/l.

Sensor Glucose (mg/dL or mmol/L) (Glicose do sensor
(mg/dl ou mmol/l)) O valor de glicose do sensor.

ISIG value (Valor ISIG) Sinais de entrada (ISIG), a serem lidos no sensor,
medidos em nanoamperes (nA).

Mais informações acerca dos ficheiros CSV exportados pelo
CareLink Pro

O título no topo dos ficheiros CSV inclui os seguintes dados:

• nome do doente

• lista de dispositivos seleccionados e respectivos números de série

• intervalo de datas seleccionado

Cada bloco de colunas apresenta um título que inclui o seguinte:

• nome do dispositivo a que se refere o bloco de dados

• número de série desse dispositivo

Se os dados não forem visualizados conforme o previsto

São vários os factores que podem fazer com que os dados dos CSV sejam visualizados de

forma diferente da prevista.

• as alterações da data ou hora no dispositivo podem influenciar a sequência dos registos ou

fazer com que sejam visualizados registos fora do intervalo de datas seleccionado;

• se existirem grandes intervalos entre leituras sucessivas do dispositivo, os dados podem ser

apresentados em vários blocos.
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Glossário

% da diferença média absoluta (Mean Absolute Difference ou MAD%) - Representa o nível de
exactidão na calibração entre as leituras de GS do sensor e do medidor. Quanto menor for este
número, maior será a exactidão da calibração. A MAD% é calculada a partir da diferença entre
pares de leituras de GS registadas pelo sensor e registadas pelo medidor em momentos próximos,
dividindo este valor pela leitura do medidor de glicemia e achando a média de todos os pares.

Análise da A1C - Análise da hemoglobina A1C, usada para interpretar o nível de glicemia ao longo
de um período de tempo.

Análise da HbA1c - Análise da hemoglobina A1C, usada para interpretar o controlo da glicemia ou
a média de níveis ao longo de um período de 2 a 3 meses.

Área por baixo da curva ("Area Under the Curve" ou AUC) - Indica a quantidade de ocorrências
de níveis glicémicos elevados ou baixos, em referência a valores predefinidos. Os dados das
ocorrências indicam a frequência dos aumentos ou diminuições da glicemia. A AUC indica a
magnitude dos eventos, mostrando o alcance e a duração do desvio.

Aviso de calibração - A bomba de insulina emitirá automaticamente de 12 em 12 horas um alarme
Medir GS até HH:MM, para indicar que o actual valor de calibração já não é válido. O valor do aviso
de calibração é a quantidade de tempo que terá de decorrer antes que o actual valor de calibração
expire, quando o utilizador pretende ser recordado da necessidade de calibração. Por exemplo,
se a opção do aviso de calibração for configurada para 2 horas, o alarme Medir GS até HH:MM será
emitido 2 horas antes de a calibração ser necessária.

Aviso de nível baixo no reservatório - Aviso programável que notifica o utilizador com um alerta
quando resta no reservatório da bomba de insulina um número específico de unidades ou quando
resta uma determinada quantidade de tempo para o reservatório ficar vazio.

Bolus áudio - A bomba de insulina pode ser programada para que o utilizador ouça um sinal sonoro
ao seleccionar uma quantidade de insulina de bolus (0,5 ou 1,0 unidade) para ser administrada.
Esta função é útil quando é difícil ver os botões da bomba.

Bolus de alimentação - Uma dose de insulina administrada para compensar a subida previsível da
glicemia que ocorre após a ingestão de alimentos.

Bolus de correcção - Quantidade de insulina necessária para restaurar os valores normais de glicemia
em caso de um nível elevado de glicemia.

Bolus de Onda Dupla (Dual Wave®) - Combinação de um bolus normal que é administrado
imediatamente, e seguido por um bolus de Onda Quadrada. A componente de Onda Quadrada
é administrada uniformemente ao longo de um período de tempo.

Bolus de Onda Quadrada (Square Wave®) - Bolus administrado de maneira uniforme ao longo de
um período especificado de tempo (de 30 minutos a 8 horas).

Bolus expresso - Método de administração de um qualquer tipo de bolus, usando o botão de bolus
expresso da bomba de insulina.
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Bolus Fácil (Easy Bolus™) - Método de administração de um bolus normal com o botão Bolus Fácil
da bomba.

Bolus manual - Item opcional disponível no MENU BOLUS quando o Bolus Wizard está activado.
Método de programar um bolus sem o Bolus Wizard.

Bolus máximo - A quantidade máxima de insulina de bolus que a bomba administrará de uma só
vez (definida pelo utilizador).

Bolus Normal - Administração imediata de uma quantidade especificada de unidades de insulina.

CareLink®Personal - Serviço online que permite a gestão dos dados da diabetes através da Internet.

CH - Carbohidratos.

ComLink - Dispositivo emissor-receptor de radiofrequência (RF) usado para transferir dados da
bomba de insulina Paradigm para o computador.

Componente de onda quadrada - A segunda parte de um bolus de Onda Dupla. A componente de
Onda Quadrada é administrada uniformemente ao longo de um período de tempo após a
administração da componente imediata.

Com-Station - Dispositivo utilizado para transferir dados da bomba de insulina MiniMed 508 e de
medidores capilares de outros fabricantes para o computador.

Concentração de insulina - Potência ou tipo da insulina que o médico prescreveu para o utilizador.
Esta afecta o índice de insulina administrado pela bomba. Se a concentração de insulina do
utilizador se alterar, será necessário reprogramar na bomba os padrões basais e os índices
máximos do bolus e basal.

Conjunto de infusão - Dispositivos usados para introduzir e fixar uma cânula sob a pele e para
transportar a insulina até ao local de inserção através de um tubo que parte da bomba de insulina.

Dose de insulina basal - Uma infusão contínua de insulina administrada automaticamente por hora
por uma bomba de insulina, com base em perfis pré-programados e índices personalizados
definidos na bomba. A bomba administra uma infusão diária de insulina que, geralmente, supre
as necessidades de fundo durante períodos de jejum (por exemplo, durante a noite e entre as
refeições).

Enviar - Processo de transferência de dados da bomba de insulina ou medidor para o servidor
CareLink® Personal.

Etapa - Medida de insulina que é definida e usada pelo utilizador para administrar o Bolus Fácil.

Factor de bolus de correcção - Valor da redução do seu nível de glicemia conseguido com 1,0
unidade de insulina. Este factor é utilizado para calcular a quantidade de um bolus de correcção
quando o seu nível de glicemia é elevado. (nível de GS) - (objectivo de GS) = X. X ÷ (factor de bolus
de correcção) = quantidade de bolus de correcção

Função Padrões - Função alargada da bomba que permite programar índices basais opcionais
(Padrão A, Padrão B) que suportam actividades ou padrões de glicemia que não fazem parte da
rotina diária, mas que são habituais no estilo de vida do utilizador. Estas actividades podem ser
um desporto que o utilizador pratica uma vez por semana, uma mudança no padrão de sono ao
fim-de-semana ou alterações hormonais durante o ciclo menstrual.

Glicemia elevada - A bomba emitirá um alarme se o sensor indicar que o nível de glicose do sensor
do utilizador é igual ou superior a este valor. Dispõe da opção de activar ou desactivar esta função.

Glicose baixa - A bomba de insulina emitirá um alarme se o sensor indicar que o nível de glicose do
utilizador é igual ou inferior a este valor. Dispõe da opção de activar ou desactivar esta função.

GS - Abreviatura de glicose no sangue

HbA1c - Hemoglobina glicosada

Hemoglobina A1C -  Hemoglobina glicosada

Hiperglicemia - Nível elevado de glicose no sangue demonstrado através da monitorização dos
níveis de glicemia na presença ou ausência dos seguintes sintomas: náuseas, vómitos, visão turva,
dores de cabeça, perturbações gástricas, micção frequente de grandes quantidades de urina e
letargia.
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Hipoglicemia - Nível baixo de glicose no sangue demonstrado através da monitorização dos níveis
de glicemia na presença ou ausência dos seguintes sintomas: fome excessiva, tremores,
transpiração, visão instável, sensação de cabeça vazia, dores de cabeça, dificuldades na articulação
da fala, alterações súbitas de humor ou da personalidade.

Identificação do transmissor (ID transm) - Indica o número de série do transmissor que está a ser
utilizado.

Índice basal - Configuração da bomba de insulina que permite uma infusão de insulina contínua de
modo a manter a estabilidade da glicemia entre refeições e durante a noite. A insulina basal imita
a administração de insulina pelo pâncreas que supre todas as necessidades de insulina do corpo
não relacionadas com a ingestão de alimentos.

Índice basal temporário (basal temp) - Insulina basal temporária única com uma quantidade e
duração especificadas. Utilizada para suprir as necessidades de insulina para actividades ou
condições especiais que não fazem parte da rotina diária normal.

Insulina basal máxima - A quantidade máxima de insulina basal que a bomba de insulina
administrará de uma só vez (Definida pelo utilizador).

Insulina de bolus - Uma dose de insulina administrada para compensar uma subida previsível da
glicemia (como acontece após uma refeição ou lanche) ou para baixar uma glicemia elevada até
valores normais.

ISIG - Valores do sensor que indicam se os componentes electrónicos do transmissor num sistema
acrescido de sensor estão a funcionar correctamente. Se observar um valor ISIG inferior a 24,00
nA ou superior a 29,00 nA, contacte a assistência ao produto. Pode ter chegado o momento de
substituir o seu transmissor.

Ligação
(1) Ligação para activar e configurar a opção do medidor que permite à bomba de insulina receber
as leituras de GS de um medidor que comunica com a bomba de insulina.
(2) É ainda usada neste sistema como sinónimo de hiperligação. Ao clicar na ligação de hipertexto,
o utilizador é levado a outro ponto no sistema ou a outro sítio da Web.

Medidor - Dispositivo médico para determinar a concentração aproximada da glicemia. Uma
pequena gota de sangue é colocada numa tira de teste descartável; o medidor de glicose no
sangue efectua a leitura da tira e usa esta leitura para calcular o nível de glicemia. O medidor
mostra então o nível em mg/dl ou mmol/l.

Opção do medidor - Função que permite à bomba de insulina receber leituras de GS a partir de um
medidor de GS ligado.

Padrão standard - O padrão basal normal que suporta a sua actividade diária habitual. Quando a
função Padrões está desactivada, a bomba utiliza o seu padrão standard (basal).

Padrões basais - O utilizador pode programar até três padrões diferentes de índice basal na sua
bomba para a administração da insulina basal: Padrão, A e B. Para cada padrão, é possível
configurar até 48 índices basais.

Perfil basal - Índice basal com hora de início e de fim. O utilizador pode programar vários perfis
diferentes na bomba de insulina, cada um dos quais com um índice basal diferente, durante um
período de 24 horas, para alcançar um melhor controlo da glicemia.

RF - Radiofrequência (RF).

Sensibilidade à insulina - Quantidade em mg/dl (ou mmol/l) da redução do seu nível de glicemia
(GS) conseguida com uma unidade de insulina (Dados do Bolus Wizard).

Suspender - Função que interrompe toda a administração de insulina pela bomba. Todas as actuais
administrações de bolus e/ou enchimentos são canceladas. A administração do índice basal é
colocada em pausa até ser retomada.

Taxa carb (Taxa de carbohidratos) - A quantidade de carbohidratos compensada por uma unidade
de insulina (Ver também Taxa porção).

Taxa prç (Taxa de porções) - Quantidade de insulina necessária para compensar uma (1) porção de
carbohidratos (Ver também Taxa carb).

Temp - Temporário.
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Teste às cetonas - As cetonas são resíduos produzidos no corpo quando este é forçado e queimar
gordura em vez de glicose para obter energia. Pode ser um sinal de falta de insulina no corpo. A
análise às cetonas mede a quantidade de cetonas concentradas no sangue ou urina.

Unidades de carbohidratos - A ingestão de alimentos ao utilizar Bolus Wizard. Introduzida como
gramas ou porções (de carbohidratos).
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